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Introduction 

License Agreement 
HIGHWAY CAPACITY SOFTWARE™, TRANSYT-7F™, AND HIGHWAY SAFETY SOFTWARE™ 
 
HCS2022™ END USER LICENSE AGREEMENT 
 
Copyright © 2021 University of Florida. All rights reserved. 
 
This is an agreement between you and the University of Florida Board of Trustees for the benefit of the McTrans 
Center. 
 
BY USING THE PROGRAMS WITHIN THE ELECTRONIC TRANSMITTED PACKAGE OR DIRECT DOWNLOAD 
(“SOFTWARE”), YOU AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT. DO NOT USE 
THE SOFTWARE WITHOUT FIRST READING AND UNDERSTANDING THE TERMS OF THIS LICENSE 
AGREEMENT. 
 
If you do not agree with the terms of this license, discontinue use, delete and/or return the unused Software 
immediately to the distributor from which it was obtained. 
 
1. LICENSE: In consideration of the required license fee, the University of Florida McTrans Center (hereinafter 
called “McTrans”) hereby grants you (hereinafter called “End User”) a nonexclusive license to use the enclosed 
HIGHWAY CAPACITY SOFTWARE, TRANSYT-7F, and HIGHWAY SAFETY SOFTWARE in HCS2022 
(hereinafter called “Software”) as described in the applicable portion of section 3 for a period in which the End User 
pays the subscription fee established by McTrans. 
 
2. OWNERSHIP: This license is not a sale of the Software; it is a license to use the Software under the terms of 
this License Agreement.  
 
3. USE: The Software is licensed to End Users for a particular use, depending on the particular license that is 
designated on order and described in this Section 3. 
 
a. Single Office License. The End User may use the Software on any number of computers within End User’s 
immediate office, which is defined as a single organizational unit, having a unique function, comprising one or more 
contiguous rooms in a single location. All persons using the Software are also End Users. End Users may also use 
the Software on portable computers while on official travel and on home computers, as long as ALL such use is on 
behalf of the office for which this Software License was purchased. This Software License does not authorize the 
use of the Software at any offices that are related to that single organizational unit but are not located at the same 
geographic location, even if the Software is stored on a portable computer. If you have any questions as to the 
validity of your End User License, contact McTrans. 
 
b. Academic License. The End User may use the Software only within a laboratory within End User’s immediate 
school, which is defined as a single school unit, having a unique function, comprising one or more contiguous rooms 
in a single location, up to the permitted (purchased) number of copies, provided the use is supervised in a classroom 
setting for teaching or research purposes, and appropriate protection is in place against students copying the 
Software and taking it out of the lab. The responsibility for ensuring this protection of the Software rests with the 
End User. Multiple laboratories require multiple licenses. The Software may not be installed or used on any 
computer outside of the licensed laboratory under the Academic License, including (but not limited to) any office, 
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home, networked or portable computer. If you have any questions as to the type or validity of your End User License, 
contact McTrans. 
 
WARNING! If this license is a Single Office License for use in traffic and transportation applications, the Software 
may not be used for classroom or workshop instruction, demonstrations, conferences or other similar purposes 
without the express, written consent of McTrans. (Contact McTrans for an Academic License.) If this license is an 
Academic License for use in training or educational applications, the Software may not be used for traffic and 
transportation applications or other similar purposes without the express, written consent of McTrans. (Contact 
McTrans for an Applications License.) 
 
4. NETWORK INCOMPATIBILITIES: McTrans is not able to provide technical support for issues resulting from 
network incompatibilities. 
 
5. GENERAL: The Software is not designed for network use, and such use is not supported. No network use is 
permitted, including but not limited to, using the Software either directly or through commands, data or instructions 
from or to a computer not already licensed and part of the internal network, for Internet or web hosting services or 
by any user not licensed to use this copy of the Software through a valid license from McTrans. 
 
6. COPY RESTRICTIONS: Unauthorized copying, distribution, or dissemination of the Software is expressly 
prohibited. End User may be held legally responsible for any copyright infringement that is caused, encouraged, or 
enabled by failure to abide by the terms of this license. Subject to these restrictions, End User may make copies of 
the Software for backup purposes and for use of the Software on any computers located within its office complex, 
as described in paragraph 3. Under no circumstances may the Software or associated printed documentation be 
copied for sale, distribution, or dissemination, except as provided in paragraph 3, without the express, written 
consent of McTrans. End User may reproduce the associated documentation as necessary to use within the 
geographic location for which the license is granted. End User may not modify, adapt, translate, reverse engineer, 
decompile, disassemble, or create derivative work from the Software or any associated written materials without 
the prior written consent of McTrans. ANY SUCH ACTIVITY OR PRODUCT BECOMES THE PROPERTY OF 
McTRANS. 
 
7. TRANSFER RESTRICTIONS: The Software is licensed only to the End User, and this License Agreement may 
not be assigned or transferred to anyone without the prior written consent of McTrans. Any authorized transferee 
of this License Agreement shall be bound by the terms of this License Agreement. End User may not transfer, 
assign, rent, lease, sell, or otherwise dispose of the Software except as expressly provided in this License 
Agreement.  
 
8. REGISTRATION AND SUPPORT: This license is automatically registered to the person or entity that purchased 
it. If the End User wishes to change the registration, he or she must fill out and return the registration card contained 
in this package. McTrans may, from time to time, revise or update the Software to correct bugs or add minor 
improvements. McTrans will supply, at its discretion, minor updates to the End User without additional charge and 
will provide reasonable telephone or email support to the End User during the normal business hours of McTrans 
for the period for which End User pays the subscription fee established by McTrans. McTrans reserves the right to 
determine the extent of the support. McTrans reserves the right to make substantial revisions and enhancements 
to the Software and to market such substantially revised versions as separate products. End User shall not be 
entitled to receive such separate products without additional charge. Upon release of any such revised version of 
the Software, the obligation to provide the above described technical support services to End User shall cease, 
unless End User chooses to pay to license the enhanced version of the Software, whether or not the End User has 
previously requested or received support on the prior version. 
 
9. LIMITED WARRANTY AND LIMITATIONS OF REMEDIES: McTrans warrants the magnetic or optical medium 
on which the Software is furnished to be free from defects in material and workmanship under normal use for a 
period of thirty (30) days from the date of delivery to the End User as evidenced by a copy of invoice. The entire 
liability and End User’s exclusive remedy shall be the replacement of any diskette found to be defective. Defective 
diskettes should be returned with a copy of the End User’s invoice to the distributor from which the Software was 
obtained. End User agrees that it is the responsibility of End User to understand fully the limitations of and 
assumptions underlying the Software and not to make use of the Software without the assistance of personnel with 
appropriate expertise. End User accepts all responsibility for review, application, and use of the program output and 
accepts all responsibility for assurance that the output meets provisions of any applicable design code, standard, 
or any project specification.
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EXCEPT AS PROVIDED ABOVE, THE PRODUCT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. McTRANS DOES NOT WARRANT THAT 
THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET END USER’S REQUIREMENTS OR THAT THE 
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE. THE ENTIRE RISK AS TO 
THE QUALITY AND PERFORMANCE OF THE PRODUCT IS WITH THE END USER. IN NO EVENT WILL 
McTRANS BE LIABLE TO END USER FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, 
OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO 
USE THE SOFTWARE EVEN IF McTRANS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, 
OR FOR ANY CLAIM BY ANY OTHER PARTY. THE ABOVE WARRANTY GIVES END USER SPECIFIC LEGAL 
RIGHTS AND END USER MAY ALSO HAVE OTHER RIGHTS IN THE UNITED STATES WHICH VARY FROM 
STATE TO STATE. USE OF THE SOFTWARE WHERE THE END USER BELIEVES OR HAS REASON TO 
BELIEVE THAT DAMAGE MAY OCCUR IS A VIOLATION OF ANY AND ALL WARRANTIES. McTRANS HAS NO 
KNOWLEDGE OF THE HARDWARE OR SOFTWARE CONFIGURATIONS OF THE END USER AND ASSUMES 
NO LIABILITY FOR THEIR DAMAGE. 
 
10. TERMINATION: This license is effective from the date End User receives the Software until this License 
Agreement is terminated. End User may terminate it by returning or destroying all copies of the Software and 
associated documentation in End User’s possession or control. If any terms of this license are breached by End 
User, the license shall terminate immediately. 
 
11. GOVERNING LAW: This License Agreement shall be governed by the laws of the State of Florida, U.S.A. Venue 
for all disputes related to this License Agreement shall be in the United States District Court of the Northern District 
of Florida, Gainesville Division, or in the Circuit Court of the Eighth Judicial Circuit for Alachua County Florida. 
 
12. U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and associated documentation are provided with 
RESTRICTED RIGHTS. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set 
forth in subdivision (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at 52.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48CFR52.227-19. The 
contractor is McTrans, University of Florida, PO Box 116585, Gainesville, FL 32611-6585. 
 
13. EXPORT REGULATION: The Software may be subject to U.S. export control laws, including the U.S. Export 
Control Reform Act and its associated regulations. End User will not directly or indirectly, export, re-export, or 
release the Software to, or make the Software accessible from, any country, jurisdiction or person to which export, 
re-export, or release is prohibited by applicable law. End User will comply with all applicable laws and complete all 
required undertakings (including obtaining any necessary export license or other governmental approval) prior to 
exporting, re-exporting, releasing, or otherwise making the Software available outside the U.S.  
 
14. INTEGRATION: This License Agreement is the complete and exclusive statement of the agreement between 
End User and McTrans and supersedes any proposal or prior agreement, oral or written, and any other 
communications between End User and McTrans relating to the subject matter of this License Agreement. This 
License Agreement may only be modified by a written agreement made subsequent to the date hereof and signed 
by both parties. 
 
15. SEVERABILITY: If any portion of this License Agreement shall be declared void or a nullity by a court of 
competent jurisdiction then the remainder shall survive and remain in full force. Should you have any questions 
concerning this license, you may contact the McTrans Center, University of Florida, PO Box 116585, Gainesville, 
FL 32611-6585, U.S.A., [1] (352) 392-0378. 
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McTrans Center, University of Florida Transportation Institute 
PO Box 116585, Gainesville  FL  32611-6585 
Telephone: 1-800-226-1013  Fax: 352-392-6629 
Web: mctrans.ce.ufl.edu  Email: mctrans@ce.ufl.edu 
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Getting Started 

Getting Started 
To begin, click on File then New (or the "New File…" button on the Start page). 

Normal Windows keyboard and mouse functions are available. Tabbing, clicking to a new field, or pressing the 
Enter key will trigger a recalculation and update the report. 

 

Freeways Analysis 

Freeways analyses will estimate Capacity and Level of Service (LOS) for a given set of traffic and geometric 
conditions. This type of analysis is oriented toward the evaluation of an existing or planned segment or facility. The 
methodology and procedures of application use the HCM Chapter 10, 12, 13, and 14 procedures. 

 

Freeway Facility Reliability Analysis 

Freeway Facility Reliability analyses evaluate the travel time reliability experiences by motorists on an urban or rural 
freeway facility. Travel time reliability reflects the distribution of trip travel time over an extended period of time. The 
distribution arises from the occurrence of a number of factors that influence travel time (e.g., weather events, 
incidents, work zone presence, etc.). The distribution describes how often these factors occur and how bad 
operations are as a result. The methodology of the application uses the HCM Chapters 11 and 25 procedures. 
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General Controls 

Menu Items 
New – Creates a new Freeways or Freeways Reliability file (*.xuf or *.xfr) and starts a new analysis project; shortcut 
is Ctrl+N 

Basic Freeway Segment – Creates a new Freeways file (*.xuf) and starts a new Basic Segment analysis 
project 

Freeway Merge Segment – Creates a new Freeways file (*.xuf) and starts a new Merge Segment analysis 
project 

Freeway Diverge Segment – Creates a new Freeways file (*.xuf) and starts a new Diverge Segment 
analysis project 

Freeway Weaving Segment – Creates a new Freeways file (*.xuf) and starts a new Weaving Segment 
analysis project 

Freeway Facility – Creates a new Freeways file (*.xuf) and starts a new Facility analysis project 

Freeway Facility with Segmentation Tool – Creates a new Freeways file (*.xuf) and starts a new Facility 
analysis project through the Segmentation tool 

Planning-Level Freeway Facility Analysis – Creates a new Freeways file (*.xuf) and starts a new Facility 
Planning analysis project 

Freeway Reliability Analysis – Creates a new Freeways Reliability file (*.xfr) and starts a new Reliability 
analysis project 

Open – Opens an existing Freeways or Freeways Reliability file (*xuf, *.xfr, *.xff, *.xhf, *.xhr, *.xhw, or *.csv); shortcut 
is Ctrl+O 

Example Folder – Opens folder with all HCS examples in File Explorer 

Save – Saves an open Freeways or Freeways Reliability file (*.xuf or *.xfr) using the current file name; shortcut is 
Ctrl+S 

Save As… – Saves an open Freeways or Freeways Reliability file (*.xuf or *.xfr) using a specified file name; shortcut 
is F12 

Close – Closes an open Freeways or Freeways Reliability file (*.xuf or *.xfr); shortcut is Ctrl+W 

Units 

 USC Units – Changes the units of the current file to U.S. Customary 

 Metric Units – Changes the units of the current file to Metric 

Print – Brings up printer selection and prints a Freeways report to the printer or specified file type; shortcut is Ctrl+P 

Print Preview – Displays preview of current report before printing; shortcut is Ctrl+F2 

View – View menu items are only available for Freeways analyses, not Reliability analyses 

Page View – Changes the view to display inputs and report by pages; shortcut is F9 
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 Full View 

Report -> Right – Changes the view to display both the input screen and report simultaneously; 
the report is displayed on the right portion of the screen; shortcut is F10 

Report -> Bottom – Changes the view to display both the input screen and report simultaneously; 
the report is displayed on the bottom portion of the screen; this function is only available for single 
segment analyses; shortcut is F11 

Report 

 Formatted Report – Displays formatted report including the most important values; shortcut is F4 

 Text Report – Displays text report with input, intermediary, and final results; shortcut is F6 

Heat Map Report – Displays graphical representation of data where the individual values contained in a 
matrix are represented as colors; Density, LOS, v/c, and d/c ratios are included as heat maps; this report 
is only available for a Freeway Facility analysis; shortcut is F7 

Import From CSV – Imports the facility inputs of each segment and analysis period from a CSV file into the *.xuf 
file; this function is only available for a Freeway Facility analysis 

Export – Export menu items are only available for a Freeway Facility analysis 

Facility -> CSV – Exports the inputs of each segment and analysis period from the *.xuf file into a CSV file 
with segments in ascending order; this function is only available for a Freeway Facility analysis  

Facility -> Graph – Exports the facility graphic found on the Segments page to a PNG image file 

Default Settings – Opens a dialog box for the user to input defaults for Analyst, Agency, and Jurisdiction, which 
will be applied to all new files; also allows selection of USC or SI units, which will be applied to all new files; other 
options for Export to CSV and Reports are provided for selection and will be applied to all new Freeways files; 
shortcut is Alt+F 

Reliability Analysis – Opens Freeways Reliability and loads current Freeways file as the base file in the Reliability 
analysis; this is only available for a Freeway Facility analysis 

Reliability Planning – Opens the Reliability Planning Calculator for the user to input all the necessary information 
to calculate results using the planning procedure; this is only available for a Reliability analysis 

Help 

Contents – Provides access to glossary, acknowledgements, copyrights, and information on the HCM 
procedures; shortcut is Ctrl+F1 

Index – Allows user to search keywords within the glossary 

Search – Allows the user to search for any word within the glossary 

User Guide – Opens a comprehensive user guide in PDF format; shortcut is Ctrl+G 

HCM6 Reference Guide – Opens the McTrans website in the default web browser to access the Highway 
Capacity Manual Reference Guide PDF 

HCS Updates – Sends the HCS version number anonymously without any personally identifiable 
information to McTrans to check for a newer version 

HCM/HCS Training – Opens the McTrans Training Page in the default web browser to view the latest 
training opportunities 

HCQS Web Page – Opens the TRB Highway Capacity and Quality of Service Committee page in the default 
web browser 
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Support 

Frequently Asked Questions – Opens the McTrans support page for HCS in the default web 
browser 

HCS on the Web – Opens the McTrans HCS Overview page in the default web browser 

McTrans on the Web – Opens the McTrans home page in the default web browser 

E-mail McTrans – Composes a new e-mail addressed to McTrans in the default e-mail client with 
registration number, serial key, module, and version number already populated in the Subject field 

About HCS – Opens an about window with software version information, EULA, general 
acknowledgements, and other relevant links 

CORSIM 

View Animation – Sends data to the TSIS-CORSIM program for simulation and/or animation purposes, 
TRAFVU can be opened within TSIS-CORSIM case to allow user to view animation; shortcut is Ctrl+Shift+A 

Generate TRF File – Saves an open Freeways file (*.xuf) as a CORSIM file (*.trf), which is a file that 
contains the input data used to define a CORSIM network and to drive the CORSIM simulation for a single 
simulation case; shortcut is Ctrl+Shift+T 

TransModeler 

View Animation – Sends data to the TransModeler application by Caliper Corporation for simulation and/or 
animation purposes 

Exit – Exits the HCS Freeways module; shortcut is Alt+F4 
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Freeway Facilities 

HCM Chapter 10 
The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity 
Manual (HCM) for analyzing Freeway Facilities. This chapter’s methodology relies on the freeway segment 
methodologies in Chapters 12, 13, and 14. These methods focus on a single analysis period of interest, generally 
the peak 15 minutes within a peak hour. This chapter’s methodology allows for the analysis of multiple and 
contiguous 15-min analysis periods and is capable of identifying breakdowns and the impact of such breakdowns 
over space and time. In essence, the methodology amalgamates hundreds or even thousands of individual 
segment/analysis period analyses into a single facility analysis. It also allows for managed lanes and work zone 
analysis. 

A freeway is a separated highway with full control of access having two or more lanes in each direction dedicated 
to the exclusive use of motorized traffic. Freeway facilities are composed of various uniform segments that may be 
analyzed to determine capacity and LOS. Three types of segments are found on freeways: 

 Basic freeway segments: All segments that are not merge, diverge, or weaving segments—whether general 
purpose or managed lanes. Those are described in more detail in Chapter 12. 

 Freeway weaving segments: Segments in which two or more traffic streams traveling in the same general 
direction cross paths along a significant length of freeway without the aid of traffic control devices (except 
for guide signs). Weaving segments are formed when a diverge segment closely follows a merge segment 
or when a one-lane off-ramp closely follows a one-lane on-ramp and the two are connected by a continuous 
auxiliary lane. These segment types occur on both general purpose and managed lane (ML) facilities. In 
the latter case, and depending on the geometry, that segment could be labeled as an ML Weaving or an 
ML Access segment. Details for those designations are provided in Chapter 13. 

 Freeway merge and diverge segments: Segments in which two or more traffic streams combine to form a 
single traffic stream (merge) or a single traffic stream divides to form two or more separate traffic streams 
(diverge). These segment types occur on both general purpose and managed lane facilities. Details for 
those segments are provided in Chapter 14. 

This chapter covers the core freeway facilities methodology, which may include managed lanes as part of the facility. 
The analysis is limited to a single study period not to exceed 24 h. Extensions of the core method to longer study 
periods are covered in Chapter 11, Freeway Reliability Analysis. Those extensions are intended to account for (a) 
the longer-term effects of both recurring (i.e., bottlenecks) and nonrecurring (e.g., due to weather, incidents, or work 
zones) congestion on freeway facility operations, and (b) the effects of ATDM strategies in mitigating some of those 
negative impacts. 

HCM Chapter 25 
Chapter 25 is the supplemental chapter for Chapter 10, which describes the core methodology for freeway facilities, 
and Chapter 11, which presents a methodology for evaluating freeway reliability and active traffic and demand 
management (ATDM) strategies. The computations used by these methodologies are detailed in this supplemental 
chapter. The documentation is closely tied to FREEVAL, the computational engine for Chapter 10 and Chapter 11.
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Chapter 25 presents a glossary of all relevant variables used in the procedures and the computational engine, 
provides details of the undersaturated and oversaturated procedures, describes details for work zone analysis, 
develops the planning-level methodology for freeway facilities, discusses the mixed-flow model for composite 
grades, develops the freeway calibration methodology at three levels, discusses freeway scenario generation, 
presents an overview of the computational engine structure, and presents example problems. 

LIMITATIONS OF THE METHODOLOGIES 

The completeness of the analysis will be limited if freeway segment cells in the first time interval, the last time 
interval, and the first freeway segment do not have demand-to-capacity ratios of 1.00 or less. The methodology can 
handle congestion in the first interval properly, although it will not quantify any congestion that could have occurred 
before the first time interval. To ensure a complete quantification of the effects of congestion, it is recommended 
that the analysis contain an initial undersaturated time interval. If all freeway segments in the last time interval do 
not exhibit demand-to-capacity ratios less than 1.00, congestion will continue beyond the last time interval, and 
additional time intervals should be added. This fact will be noted as a difference between the vehicle miles of travel 
desired at the end of the analysis (demand flow) and the corresponding vehicle miles of travel flow generated 
(volume served). If queues extend upstream of the first segment, the analysis will not account for the congestion 
outside the freeway facility but will store the vehicles vertically until the congestions clears the first segment. The 
same process is followed for queues on on-ramp segments. 

The methodology for oversaturated conditions described in this chapter is based on concepts of traffic flow theory 
and assumes a linear speed-flow relationship for densities greater than 45 passenger cars per mile per lane 
(pc/mi/ln). This relationship has not been extensively calibrated for field observations on U.S. freeways, and analysts 
should therefore perform their own validation from local data to obtain additional confidence in the results of this 
procedure. 

The procedure described here becomes extremely complex when the queue from a downstream bottleneck extends 
into an upstream bottleneck, causing a queue interaction. When such cases arise, the reliability of the methodology 
is questionable, and the user is cautioned about the validity of the results. For heavily congested directional freeway 
facilities with interacting bottleneck queues, a traffic simulation model might be more applicable. Noninteracting 
bottlenecks are addressed by the methodology. 

The procedure focuses on analyzing a directional series of freeway segments. It described the performance of a 
facility but falls short of addressing the broader transportation network. The analyst is cautioned that severe 
congestion on a freeway—especially freeway on-ramps—is likely to affect the adjacent surface street network. 
Similarly, the procedure is limited in its ability to predict the impacts of an oversaturated off-ramp and the associated 
queues that may spill back onto the freeway. Alternative tools are suitable to evaluate these impacts. 

Operational Data 
First, the user enters the General Information into the respective fields: Analyst, Agency, Date, and Time Analyzed. 
Then, the user enters the Site Information into the respective fields: Jurisdiction, Analysis Year, and Project 
Description. Facility-wide values are also provided on the General page under Facility Global Inputs to specify Jam 
Density, Density at Capacity, Queue Discharge Capacity Drop, Area Type, presence of Managed Lanes, Demand 
Factor, and application of the Mixed Flow Model. The ‘Mixed Flow Model’ checkbox is enabled only when the facility 
has Basic segments coded. If any other segment type is added to the facility, the checkbox will be disabled and the 
mixed flow model will not be applied. If ‘Mixed Flow Model’ is checked and applied, two new inputs will be added to 
the Details page of the Basic segment(s). A Segments Global Inputs section is provided for the user to apply inputs 
to all segments within the coded facility to simplify inputting values throughout the whole facility. These fields include 
Freeway Lanes, Freeway FFS, Freeway Terrain Type, Freeway Peak Hour Factor, Freeway Total Trucks, Ramp 
Lanes, Ramp FFS, Ramp Terrain Type, Ramp Peak Hour Factor, and Ramp Total Trucks. There are checkboxes 
by each of these fields for the user to specify if they want to apply the inputs to each of the segments within the 
facility. For example, if one Freeway FFS is desired for every segment within the facility, the user can enter the 
value in the Freeway FFS textbox, check the checkbox next to it, and then click the Apply Global Inputs button. The 
value entered in the Freeway FFS textbox will then be applied to the Freeway FFS of each segment within the 
facility.
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Segments and Analysis Periods 

On the Segments page, the user can add, insert, or remove segments by clicking the appropriate buttons at the top 
of the screen. Adding a segment will add a row of inputs with the Segment Type of ‘Basic’ along with the values 
from the previous Basic segment or default values if following a Merge, Diverge, or Weaving segment. The user 
can add an unlimited number of segments and can manually change the inputs to the desired values. When inserting 
a segment, the user must select a segment first before clicking the ‘Insert Segment’ button. When a segment is 
inserted, it will be added to the facility before the selected segment. To remove a segment, select one or more 
segments and then click the ‘Delete Segment’ button to remove the desired segments. Analysis periods can also 
be added or deleted. Similar to inserting a segment, inserting an analysis period will add an analysis period before 
the selected analysis period. To remove an analysis period, select the desired analysis period and then click the 
‘Delete Analysis Period’ button. 

 

General Segment Inputs 

On the Segments page, each segment has a row of editable inputs. These include: Segment Type, Segment Name, 
Segment Length, Number of Lanes, and Demand. There are two additional columns for each row that are not user 
inputs. These include Volume and Segment Analysis Details, which includes a link that leads to the corresponding 
Details page. 

 

Detailed Segment Inputs 

On the Details page, the user can switch between each coded segment. Each segment has inputs for Geometric 
Data, Demand Data, and Adjustment Factors. 

The Details page of a Basic or Overlap segment is the same as the input screen of an individual Basic segment. 
Inputs required for Geometric Data include: Number of Lanes, Base Free Flow Speed or Free Flow Speed If 
Measured FFS is checked, Segment Length, Lane Width, Terrain Type, Percent Grade and Grade Length if the 
Terrain Type selected is Specific Grade, Right Side Clearance, and Total Ramp Density. Inputs required for 
Demand Data include: Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent 
Tractor-Trailers. Inputs required for Adjustment Factors include: Driver Population, Weather Type, Speed 
Adjustment Factor, Capacity Adjustment Factor, Incident Type, and Demand Adjustment Factor. There is also a 
checkbox to indicate if there is a work zone included for that analysis period. Checking this box will enable a Work 
Zone Data section with additional inputs including: Lane Closure Type, Area Type, Daylight or Night, Percent Drop 
in Capacity, Barrier Type, Lateral Distance, and Work Zone Speed Limit. If the ‘Mixed Flow Model’ checkbox from 
the Details page is checked and the model is applied, two new inputs will be added to the Demand Data section of 
the Details page of the Basic segment(s). These include: SUT Kinematic End Spot Rate and TT Kinematic End 
Spot Rate. 

The Details page of a Merge or Diverge segment is the same as the input screen of an individual Merge or Diverge 
segment, respectively. Inputs are separated with freeway data on the left and ramp data on the right. Both the 
freeway and ramp data require Number of Lanes, Free Flow Speed, Terrain Type, Percent Grade and Grade Length 
if Terrain Type is Specific Grade, Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, 
Percent Tractor-Trailers, Driver Population, Weather Type, Speed Adjustment Factor, Capacity Adjustment Factor, 
and Demand Adjustment Factor. Data specifically for ramps include the acceleration/deceleration lane lengths and 
the side of junction or location of ramp. Data specifically for the freeway include the freeway segment length and 
indication if it is a Highway or C-D Roadway. There is also an input to indicate Incident Type. 

The Details page of a Weaving segment is the same as the input screen of an individual Weaving segment. Inputs 
required for Geometric Data include: Number of Lanes, Freeway Free-Flow Speed, Weaving Configuration, Number 
of Maneuver Lanes, Short Length, Interchange Density, Terrain Type, Percent Grade and Grade Length if the 
Terrain Type is Specific Grade, Minimum Freeway-to-Ramp Lane Changes, Minimum Ramp-to-Freeway Lane 
Changes, and Minimum Ramp-to-Ramp Lane Changes. There are also checkboxes included to indicate if it is a 
Highway or C-D Roadway and to indicate if there is a Cross Weaving Managed Lane. If a cross weaving managed 
lane is present, then a new section of cross weaving inputs will enable. Inputs required for Cross Weaving include: 
General Purpose Segment Type, Minimum Cross Weaving Length, Free-Flow Speed of the Managed Lane, Cross-
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Weave Demand, Ramp Terrain Type, Percent Ramp Total Trucks, and Ramp Peak Hour Factor. Inputs required 
for Freeway Demand Data include: Freeway-to-Freeway Demand, Demand Adjustment Factor, Peak Hour Factor, 
Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-Trailers. Inputs required for Freeway 
Adjustment Factors include: Diver Population, Weather Type, Incident Type, Speed Adjustment Factor, and 
Capacity Adjustment Factor. Inputs required for On-Ramp Data include: On-Ramp Number of Lanes, On-Ramp 
Free-Flow Speed, Ramp-to-Freeway Demand, Ramp-to-Freeway Demand Adjustment Factor, Percent Ramp-to-
Freeway Total Trucks, Ramp-to-Freeway Peak Hour Factor, Ramp-to-Ramp Demand, Ramp-to-Ramp Demand 
Adjustment Factor, Percent Ramp-to-Ramp Total Trucks, and Ramp-to-Ramp Peak Hour Factor. Inputs required 
for Off-Ramp Data include: Off-Ramp Number of Lanes, Off-Ramp Free-Flow Speed, Freeway-to-Ramp Demand, 
Freeway-to-Ramp Demand Adjustment Factor, Percent Freeway-to-Ramp Total Trucks, and Freeway-to-Ramp 
Peak Hour Factor. 

If Managed Lane was checked on the General page, a new set of inputs will be enabled for Managed Lanes on 
each of the segments within the facility. Inputs required for Managed Lane Geometric Data include: Number of 
Managed Lanes, Managed Lane Type, Free-Flow Speed of the Managed Lane, Terrain Type, and Percent Grade 
and Grade Length if the Terrain Type is Specific Grade. Inputs required for Managed Lane Demand Data include: 
Managed Lane Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-
Trailers. Inputs required for Managed Lane Adjustment Factors include: Driver Population, Demand Adjustment 
Factor, Speed Adjustment Factor, and Capacity Adjustment Factor. 

 

Facility Graphic 

A facility graphic can be found on the Segments, Details, and Results pages to better visualize the facility being 
analyzed. Included in the graphic is a table listing the segment type, segment length in feet, Segment ID, number 
of general purpose lanes, and if applicable, the number of managed lanes for each segment. Underneath this 
information, is a drawing of the actual facility. On the Segments page, clicking on a particular segment, will bring 
the user to the Details page of the selected segment. Hovering over each segment will show a tooltip that provides 
information on the segment number, analyzed type, FFS, and terrain type. On both the Details page and Results 
page, the currently viewed segment will be highlighted. The user can switch the currently viewed segment by 
clicking on another segment. There are also options to change the color of the graph based on different performance 
measures, which include Flow, Speed, Density, and LOS. Selecting ‘None’ will leave the graphic white. A legend 
for the different colors appears to the side of the graphic when any of the other options are selected. Hovering over 
each segment on the Details page will show a tooltip that provides information on the segment number, analyzed 
type, FFS, and terrain type. Hovering over each segment on the Results page will show a tooltip that provides 
information on the segment number, analysis period number, flow, density, speed, and LOS. 

 

Results 

Level of Service (LOS) Criteria for Urban Freeway Facilities: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  ≤11     ≤7 
LOS B  >11 - 18   >7 - 11  
LOS C  >18 - 26   >11 – 16 
LOS D  >26 - 35   >16 – 22 
LOS E  >35 - 45   >22 – 28 
LOS F  >45 or ad/c>1.0   >28 or vd/c>1.0 

Level of Service (LOS) Criteria for Rural Freeway Facilities: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  ≤6     ≤4 
LOS B  >6 -14    >4 – 9 
LOS C  >14 - 22   >9 – 14 
LOS D  >22 - 29   >14 – 18 
LOS E  >29 - 39   >18 – 24 
LOS F  >39 or vd/c>1.0   >24 or vd/c>1.0
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Level of Service (LOS) Criteria for Basic Freeway Segments: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  ≤11     ≤7 
LOS B  >11 - 18   >7 – 11 
LOS C  >18 - 26   >11 - 16 
LOS D  >26 - 35   >16 – 22 
LOS E  >35 - 45   >22 – 28 
LOS F  >45 or v/c>1.0   >28 or v/c>1.0 

Level of Service (LOS) Criteria for Freeway Weaving Segments: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  0 - 10      0 – 6 
LOS B  >10 - 20   >6 – 12 
LOS C  >20 - 28   >12 – 17 
LOS D  >28 - 35   >17 – 22 
LOS E  >35    >22 
LOS F  >43 or v/c>1.0   >27 or v/c>1.0 

Level of Service (LOS) Criteria for Freeway Merge and Diverge Segments: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  ≤10      ≤6 
LOS B  >10 - 20   >6 – 12 
LOS C  >20 - 28   >12 – 17 
LOS D  >28 - 35   >17 – 22 
LOS E  >35    >22 
LOS F  v/c>1.0    v/c>1.0 

Planning Analysis 
Facilities Planning is based off of HCM Chapter 25 Section 6. This procedure reduces the data requirements for 
freeways facilities by assuming default values for some inputs found in operational calculations. Facility planning is 
no longer based on the segment level of the operational analysis, but instead on a section level. Sections are 
typically from ramp gore to gore, but may include only one ramp or no ramp.  

Demand is no longer input per analysis period, but 4 analysis periods of demand are estimated based on AADT 
and K-factor. The AADT input should be a single direction of data. This can be found from a two-direction AADT 
value by multiplying by the D-factor. The HCM recommends sections stay below 2 miles, particularly if they are 
ramp sections, to avoid the ramp adjustment applying for too long of a distance.  

In comparison to Freeway Facilities operational analysis, facility planning does not have section specific inputs. All 
inputs can be found on the facility page with ramp FFS, truck percent, and other factors applying to the entire facility. 
A growth factor is provided to dynamically grow or reduce the demand input. 

Facilities Report 
 

The report page shows a formatted version of the analysis in a dynamic form, reacting to changes in the General, 
Segments, and Details pages. All or a portion can be copied to the Windows clipboard for insertion into other files 
by right-clicking into the report and selecting Copy. 

Both formatted and text reports are available for viewing and printing. The formatted report provides data and results 
that are most important to the user, and are displayed in a clean and more presentable fashion. There are three 
graphs at the bottom of the report which show Volume Distribution, Speed Distribution, and Density Distribution. 
The text report provides more details to the user, rather than a summary. 

The user can switch between Text and Formatted reports, Segment and Facility reports, and the Heat Map Report 
by clicking on the buttons found at the bottom of the Report page.
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Import/Export Facility 
 

Import Facility 

To properly import facility inputs, a new Freeway Facility XUF file must be created or an existing Freeway Facility 
XUF file must be opened. The number of segments, number of analysis periods, and segment types must be coded 
beforehand for the demand and other inputs to be properly imported. For example, if demand for 3 segments is 
desired but only 1 segment is available in the XUF file, then the information stored in the CSV file cannot be 
imported. A popup will appear in Freeways saying “Cannot import demand file, number of segments is not consistent 
with XUF file.” The same is applied for inconsistent number of analysis periods and segment types. Once the 
number of segments, number of analysis periods, and segment types are consistent between the CSV file and XUF 
file, then the ‘Import > Facility From CSV’ option can be selected from the menu items. 

The first value of each line consists of the input label. Only the brackets with identifiers are required for properly 
importing. For example, it is not necessary for “Number of Segments” to be included in the label, but it is necessary 
for “[F1]” to be included for the number of segments to be properly read for importing. Import Facility also supports 
reading of partial files so not all labels are required for importing. Number of Segments, Number of Analysis Periods, 
and Segment Type are the three inputs required. All other inputs can be included, but are not necessary for 
importing to take place. The following list includes all the available labels with identifiers for the CSV file to be 
imported: 

Version 
Number of Segments [F1] 
Number of Analysis Periods [F2] 
Run Mixed Flow Model [F3] 
Managed Lane [F4] 
Jam Density [F5] 
Queue Discharge Capacity [F6] 
Density at Capacity [F7] 
Area Type [F8] 
Demand Factor [F10] 
Start Time [F10] 
Analyst [P1] 
Jurisdiction [P2] 
Agency [P3] 
Time Analyzed [P4] 
Analysis Year [P5] 
Date [P6] 
Segment Number [GB1] 
Segment Name [GB14] 
Segment Type [GB2] 
Lanes [GB3] 
Measured FFS [GB4] 
FFS [GB5] 
Length [GB6] 
Terrain Type [GB7] 
Grade [GB8] 
Grade Length [GB9] 
Right Side Clearance [GB10] 
Lane Width [GB11] 
Total Ramp Density [GB12] 
Managed Lane Type [GML1] 
Number of Managed Lanes [GML2] 
Managed Lane FFS [GML3] 
Managed Lane Terrain Type [GML4]
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Managed Lane Grade [GML5] 
Managed Lane Grade Length [GML6] 
Ramp Lanes [RB1] 
Ramp FFS [RB2] 
Ramp Side [RB3] 
Length of First Accel/Decel Lane [RB4] 
Length of Second Accel/Decel Lane [RB5] 
Ramp Terrain [RB6] 
Ramp Grade [RB7] 
Ramp Grade Length [RB8] 
Cross Weaving Effect [RB9] 
Min Cross Weaving Length [RB10] 
Highway or C-D Roadway [RB11] 
Number of Maneuver Lanes [WB1] 
Weaving Configuration [WB2] 
Short Length [WB3] 
Freeway-to-Ramp Lane Changes [WB4] 
Ramp-to-Freeway Lane Changes [WB5] 
Ramp-to-Ramp Lane Changes [WB6] 
On-Ramp Terrain [WB7] 
Off-Ramp Terrain [WB8] 
On-Ramp Grade [WB9] 
Off-Ramp Grade [WB10] 
On-Ramp Grade Length [WB11] 
Off-Ramp Grade Length [WB12] 
Interchange Density [WB13] 
Highway or C-D Roadway [WB14] 
On-Ramp FFS [WB16] 
Off-Ramp FFS [WB17] 
Mainline Demand[TB1] 
Mainline Peak Hour Factor [TB2] 
Mainline Total Trucks [TB3] 
Mainline Single-Unit Trucks [TB4] 
Mainline Driver Population [TB6] 
Mainline Weather Type [TB7] 
Mainline Incident [TB8] 
Mainline Speed Adjustment Factor [TB9] 
Mainline Capacity Adjustment Factor [TB10] 
Mainline Demand Adjustment Factor [TB11] 
Mainline SUT Kinematic End Spot Rate [TB12] 
Mainline TT Kinematic End Spot Rate [TB13] 
Mainline Include Work Zone [TB14] 
Managed Lane Demand [TML1] 
Managed Lane Peak Hour Factor [TML2] 
Managed Lane Total Trucks [TML3] 
Managed Lane Single-Unit Truck [TML4] 
Managed Lane Driver Population [TML6] 
Managed Lane Speed Adjustment Factor [TML9] 
Managed Lane Capacity Adjustment Factor [TML10] 
Managed Lane Demand Adjustment Factor [TML11] 
Access Demand ML to GP [TML12] 
Access Demand GP to ML [TML13] 
Work Zone Lane Closure Type [TWZ1] 
Work Zone Barrier Type [TWZ2]
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Work Zone Area Type [TWZ3] 
Work Zone Lateral Distance [TWZ4] 
Work Zone Daylight or Night [TWZ5] 
Work Zone Speed Limit [TWZ6] 
Work Zone Percent Drop Capacity [TWZ7] 
Ramp Demand [TR1] 
Ramp Peak Hour Factor [TR2] 
Ramp Total Trucks [TR3] 
Ramp Single-Unit Trucks [TR4] 
Ramp Driver Population [TR6] 
Ramp Weather Type [TR7] 
Ramp Incident [TR8] 
Ramp Speed Adjustment Factor [TR9] 
Ramp Capacity Adjustment Factor [TR10] 
Ramp Demand Adjustment Factor [TR11] 
Cross Weaving Demand [TR12] 
Proportion of Flow Outside 4th Lane [TR13] 
Ramp-to-Freeway Demand [TW1] 
Freeway-to-Ramp Demand [TW2] 
Ramp-to-Ramp Demand [TW3] 
Ramp-to-Freeway Peak Hour Factor [TW4] 
Freeway-to-Ramp Peak Hour Factor [TW5] 
Ramp-to-Ramp Peak Hour Factor [TW6] 
Ramp-to-Freeway Total Trucks [TW7] 
Freeway-to-Ramp Total Trucks [TW8] 
Ramp-to-Ramp Total Trucks [TW9] 
Ramp-to-Freeway Demand Adjustment Factor [TW10] 
Freeway-to-Ramp Demand Adjustment Factor [TW11] 
Ramp-to-Ramp Demand Adjustment Factor [TW12] 
Ramp-to-Freeway Single-Unit Trucks [TW13] 
Freeway-to-Ramp Single-Unit Trucks [TW14] 
Ramp-to-Ramp Single-Unit Trucks [TW15] 

From the labels Mainline Demand [TB1] and onward, additional rows are added underneath each label depending 
on the number of analysis periods included in a dataset. They are labeled as “TP#”. For example, if there are 4 
analysis periods in a dataset, there would be 4 rows under each of these labels and they would be labeled as 
follows: 

TP1 
TP2 
TP3 
TP4 

With the exception of Number of Segments, Number of Analysis Periods, and the labels that come before the TP# 
rows, every row should have a value for each segment in the dataset. If a value is not applicable for a certain 
segment, then that value for that segment is “-“. For example, if there are 11 segments and only the sixth segment 
is a weaving segment, then the row for weaving configuration would look like the following: 

Weaving Configuration [WB2],-,-,-,-,-,One-Sided,-,-,-,-,- 

If using excel, each value would be in its own cell. 

Number of Segments and Number of Analysis Periods should each have only one value following the label. For 
example if there are 11 segments and 4 analysis periods in a dataset, the rows would be as follows: 

Number of Segments [F1],11 
Number of Analysis Periods [F2],4



____________________________________________________________________________________________________ 
 Freeways User Guide    Freeway Facilities · 17 

To ensure proper labeling, it is suggested to export a facility first and then make changes to the inputs within the 
CSV file for importing. 

 

Export Facility 

To properly export facility inputs, a Freeway Facility XUF file must be opened. In the menu items, there is an 
‘Export > Facility To CSV’ option. There are two options for exporting: Ascending Order and Descending Order. If 
the ‘Ascending Order’ option is chosen, then the inputs of each segment and analysis period will be exported with 
segments in ascending order. Likewise, if the ‘Descending Order’ option is chosen, then the inputs of each segment 
and analysis period will be exported with segments in descending order. If either of these are selected, a Save As 
dialog box will appear with the default file name of ‘export.csv’ already populated. The name can be edited if 
necessary. Once saved, the CSV file can be opened from the file location in whichever default CSV application is 
set for the current computer. 
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Basic Freeway Segments 

HCM Chapter 12 
The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity 
Manual (HCM) for analyzing Basic Freeway and Multilane Highway Segments. These segments are outside the 
influence of merging, diverging, and weaving maneuvers. In the case of multilane highways, they are also outside 
the influence of signalized intersections. Because of the similar operational characteristics of basic freeway and 
multilane highway segments, they are analyzed with the same methodology. 

Chapter 12 focuses on uninterrupted flow, which refers to access-controlled facilities, with access and egress being 
controlled through grade-separated cross streets and ramp movements to access the facility. 

The methodologies in this chapter are limited to uncongested flow conditions. Uncongested flow conditions require 
that the demand-to-capacity ratio for the segment is less than or equal to 1.0. Uncongested flow on freeways and 
multilane highways further means that there are no queuing impacts on the segment from downstream bottlenecks. 
Chapter 10, Freeway Facilities Core Methodology, provides an evaluation method for analyzing oversaturated basic 
freeway segments. 

HCM Chapter 26 
Chapter 26 is the supplemental chapter for Chapter 12, Basic Freeway and Multilane Highway Segments, and 
Chapter 15, Two-Lane Highways, which are found in Volume 2 of the Highway Capacity Manual (HCM). The chapter 
provides state-specific heavy-vehicle default values that can be applied to freeway, multilane, and two-lane highway 
analyses; presents a supplemental procedure for basic freeway segments that can be used to assess their operating 
performance under mixed-flow conditions when significant truck presence, a prolonged single upgrade, or both 
exist; provides travel time versus distance curves for single-unit trucks (SUTs) or tractor-trailers (TTs) for a range 
of free-flow speeds (FFS) for use with this procedure; presents an extension of this method for composite grades 
on freeway facilities; provides suggested capacity and FFS adjustments to account for the effects of different 
proportions of motorists on a freeway or multilane highway who are not regular users of the facility; presents freeway 
capacity definitions, guidance on locating sensors for use in measuring freeway capacity, and guidance on 
estimating capacity from the collected sensor data; and provides example problems.
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Operational Data 
Project Properties 

The following inputs are general information involving the analysis and are available under the Project Properties 
section: Analyst, Jurisdiction, Agency, Time Analyzed, Analysis Year, Date, and Project Description. A checkbox 
for Design Analysis is provided. When checked, a table will be added to both the formatted and text reports, listing 
the results for the current freeway segment with different numbers of lanes. A checkbox for Service Volumes is also 
provided. Checking this will enable the D-factor and K-factor fields and will add a service volume table to the end 
of both the formatted and text reports. 

 

Geometric Data 

For Basic freeway segments, the number of lanes in the analysis direction is entered. The user chooses the type 
of Terrain (Level, Rolling, or Specific Grade). If Specific Grade is chosen, fields for Percent Grade and Grade Length 
will enable for the user to change. Lane Width, Base Free Flow Speed or Free-Flow Speed if Measured FFS is 
indicated, and Right Side Clearance are also available as inputs. Total Ramp Density is an input included for basic 
freeway segments.  

A checkbox is provided for Measured FFS to indicate if Free-Flow Speed was measured for the current analysis. 
When Measured FFS is checked for basic freeway segments, the following fields are disabled: Lane Width, Right 
Side Clearance, and Total Ramp Density.  

For basic freeways segments, a checkbox for Managed Lane is provided. When ‘Managed Lane’ is checked, three 
new sections are added to the bottom of the input screen: Managed Lane Geometric Data, Managed Lane Demand 
Data, and Managed Lane Adjustment Factors. Inputs for Managed Lane Geometric Data include: Number of 
Managed Lanes, Managed Lane Type, Free-Flow Speed of the Managed Lane, Terrain Type, and Percent Grade 
and Grade Length if the Terrain Type is Specific Grade. Inputs for Managed Lane Demand Data include: Managed 
Lane Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-Trailers. 
Inputs for Managed Lane Adjustment Factors include: Driver Population, Demand Adjustment Factor, Speed 
Adjustment Factor, and Capacity Adjustment Factor.  

 

Demand Data 

Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-Trailers are 
included as inputs for basic freeway segments. A checkbox for Mixed Flow Model is also provided and is only 
enabled when the Terrain Type is coded as Specific Grade. If ‘Mixed Flow Model’ is checked, the mixed-flow model 
will be used to assess capacity, speed, and density in addition to the traditional passenger-car-equivalent (PCE) 
method. Results of both methods will be provided in the reports. 

 

Adjustment Factors 

Both Driver Population and Weather Type are taken into account. These affect the Speed and Capacity Adjustment 
Factors. If the user chooses to override the default values based on driver population and weather type, they can 
change the adjustment factors. 

In addition to these inputs, there are inputs for Incident Type, Demand Adjustment Factor, and Work Zone. If a 
Work Zone is indicated, a new Work Zone Data section will be enabled with the following inputs: Lane Closure 
Type, Area Type, Daylight or Night, Percent Drop in Capacity, Barrier Type, Lateral Distance, and Work Zone Speed 
Limit. 
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Results 

A basic freeway segment can be characterized by three performance measures: density in passenger cars per mile 
per lane (pc/mi/ln), space mean speed in miles per hour (mi/h), and the ratio of demand flow rate to capacity (v/c). 
Since speed is constant through a broad range of flows and the v/c ratio is not directly discernible to road users 
(except at capacity), the service measure for basic freeway segments is density. 

Level of Service (LOS) Criteria for Basic Freeway Segments: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  ≤11     ≤7 
LOS B  >11 - 18   >7 – 11 
LOS C  >18 - 26   >11 – 16 
LOS D  >26 - 35   >16 – 22 
LOS E  >35 - 45   >22 – 28 
LOS F  >45 or v/c>1.0   >28 or v/c>1.0 

Design Analysis 
The design mode of HCS Freeways can be used to determine the number of lanes required for a particular target 
LOS. Simply select the ‘Design Analysis’ checkbox and a table will be added to the report, listing the density and 
LOS for each number of lanes (2-5 for Basic and Ramp segments, and 3-6 for Weaving segments). For ramp 
segments, both 1 ramp lane and 2 ramp lanes are evaluated. 

Basic Freeway Report 
The report can be displayed in either Page or Full View. If displayed in Page View, the results will automatically 
update when the user switches to the Report page. From the Report page, the user can switch between the 
formatted report and text report using the button found at the bottom of the page. The formatted report shows the 
most important results in a presentable format, while the text report shows a detailed step-by-step analysis in plain 
text. 

If displayed in Full View, the report can be displayed along with the input screen. The user has the choice of 
displaying the report to the right of the input screen or below the input screen. The report is dynamic and reacts to 
changes in the input screen. Like the Report page in Page View, the user can switch between the formatted report 
and the text report using the button found at the bottom of the report. 

All or a portion can be copied to the Windows clipboard for insertion into other files by right-clicking into the report 
and selecting Copy. The user can also change the display of the report through File Menu or with the user of 
shortcuts. See General Controls. 
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Freeway Weaving Segments 

HCM Chapter 13 
The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity 
Manual (HCM) for analyzing Freeway Weaving Segments. The chapter describes how the methodology can be 
applied to planning, operations, and design applications. The methodology can further be used to estimate the 
effects of weather and incidents on weaving segment computations, and includes extension to apply concepts to 
weaving segments on managed lanes. 

HCM Chapter 27 
Chapter 27 is the supplemental chapter for Chapter 13, Freeway Weaving Segments, which is found in Volume 2 
of the Highway Capacity Manual (HCM). This chapter provides example problems demonstrating the application of 
the Chapter 13 core methodology and its extension to freeway managed lanes. 

Operational Data 
Project Properties 

The following inputs are general information involving the analysis and are available under the Project Properties 
section: Analyst, Jurisdiction, Agency, Time Analyzed, Analysis Year, Date, and Project Description. A checkbox 
for Design Analysis is provided. When checked, a table will be added to both the formatted and text reports, listing 
the results for the current freeway segment with different numbers of lanes. A checkbox for Service Volumes is also 
provided. Checking this will enable the D-factor and K-factor fields and will add a service volume table to the end 
of both the formatted and text reports. 

 

Geometric Data 

For Weaving Segments, inputs required for Geometric Data include: Number of Lanes, Freeway Free-Flow Speed, 
Weaving Configuration, Number of Maneuver Lanes, Short Length, Interchange Density, Terrain Type, Percent 
Grade and Grade Length if Terrain Type is Specific Grade, Minimum Freeway-to-Ramp Lane Changes, Minimum 
Ramp-to-Freeway Lane Changes, and Minimum Ramp-to-Ramp Lane Changes.  

There are also checkboxes included to indicate if it is a Highway or C-D Roadway, to indicate if there is a Cross 
Weaving Managed Lane, and to indicate if there is a Managed Lane. If a cross weaving managed lane is present, 
then a new section of cross weaving inputs will enable. Inputs required for Cross Weaving include: General Purpose 
Segment Type, Minimum Cross Weaving Length, Free-Flow Speed of the Managed Lane, Cross-Weave Demand, 
Ramp Terrain Type, Percent Ramp Total Trucks, and Ramp Peak Hour Factor. If ‘Managed Lane’ is checked, a 
new set of inputs will be enabled for Managed. Inputs required for Managed Lane Geometric Data include: Number 
of Managed Lanes, Managed Lane Type, Free-Flow Speed of the Managed Lane, Terrain Type, and Percent Grade 
and Grade Length if the Terrain Type is Specific Grade. Inputs required for Managed Lane Demand Data include: 
Managed Lane Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-
Trailers. Inputs required for Managed Lane Adjustment Factors include: Driver Population, Demand Adjustment 
Factor, Speed Adjustment Factor, and Capacity Adjustment Factor. 
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Freeway Demand Data 

Inputs required for Freeway Demand Data include: Freeway-to-Freeway Demand, Demand Adjustment Factor, 
Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-Trailers.  

 

Freeway Adjustment Factors 

Driver Population and Weather Type are also taken into account. This affects the Speed and Capacity Adjustment 
Factors. However, if the user chooses to override the default values based on driver population and weather type, 
they can change the adjustment factors. In addition to these inputs, there is an input for Incident Type, which also 
affects Capacity Adjustment Factor. 

 

On-Ramp Data 

Inputs required for On-Ramp Data include: On-Ramp Number of Lanes, On-Ramp Free-Flow Speed, Ramp-to-
Freeway Demand, Ramp-to-Freeway Demand Adjustment Factor, Percent Ramp-to-Freeway Total Trucks, Ramp-
to-Freeway Peak Hour Factor, Ramp-to-Ramp Demand, Ramp-to-Ramp Demand Adjustment Factor, Percent 
Ramp-to-Ramp Total Trucks, and Ramp-to-Ramp Peak Hour Factor.  

 

Off-Ramp Data 

Inputs required for Off-Ramp Data include: Off-Ramp Number of Lanes, Off-Ramp Free-Flow Speed, Freeway-to-
Ramp Demand, Freeway-to-Ramp Demand Adjustment Factor, Percent Freeway-to-Ramp Total Trucks, and 
Freeway-to-Ramp Peak Hour Factor. 

 

Results 

LOS criteria is provided for weaving segments on freeways, collector-distributor (C-D) roads, and multilane 
highways. 

Level of Service (LOS) Criteria for Freeway Weaving Segments: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  0 - 10      0 - 6   
LOS B  >10 - 20   >6 – 12 
LOS C  >20 - 28   >12 – 17 
LOS D  >28 - 35   >17 – 22 
LOS E  >35    >22 
LOS F  >43 or v/c>1.0   >27 or v/c>1.0 

Level of Service (LOS) Criteria for Weaving Segments on Multilane Highways or C-D Roads: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  0 - 12      0 - 7   
LOS B  >12 - 24   >7 – 15 
LOS C  >24 - 32   >15 – 20 
LOS D  >32 - 36   >20 – 22 
LOS E  >36 - 40   >22 – 25 
LOS F  >40 or v/c>1.0   >25 or v/c>1.0 

Design Analysis 
The design mode of HCS Freeways can be used to determine the number of lanes required for a particular target 
LOS. Simply select the ‘Design Analysis’ checkbox and a table will be added to the report, listing the density and 
LOS for each number of lanes (2-5 for Basic and Ramp segments, and 3-6 for Weaving segments). For ramp 
segments, both 1 ramp lane and 2 ramp lanes are evaluated.
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Note that for weaving segments, some configurations may lead to LOS F for all numbers of lanes due to HCM 
equations creating a capacity less than the demand. To solve this problem, reconfigure the weaving segment to 
change NWL to 3. If this is infeasible, or NWL is already 3, the weaving segment will always be LOS F. To improve 
the LOS, adjust the demand (specifically the weaving demand) or increase the length of the segment past the 
maximum weaving length to cause the segment to be analyzed as a basic segment. 

Weaving Report 
The report can be displayed in either Page or Full View. If displayed in Page View, the results will automatically 
update when the user switches to the Report page. From the Report page, the user can switch between the 
formatted report and text report using the button found at the bottom of the page. The formatted report shows the 
most important results in a presentable format, while the text report shows a detailed step-by-step analysis in plain 
text. 

If displayed in Full View, the report can be displayed along with the input screen. The user has the choice of 
displaying the report to the right of the input screen or below the input screen. The report is dynamic and reacts to 
changes in the input screen. Like the Report page in Page View, the user can switch between the formatted report 
and the text report using the button found at the bottom of the report. 

All or a portion can be copied to the Windows clipboard for insertion into other files by right-clicking into the report 
and selecting Copy. The user can also change the display of the report through File Menu or with the user of 
shortcuts. See General Controls. 
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Freeway Merge and Diverge 
Segments 

HCM Chapter 14 
The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity 
Manual (HCM) for analyzing Freeway Merge and Diverge Segments. The procedures in this chapter focus on ramp-
freeway junctions, but guidance is also provided to allow approximate use of such procedures on multilane highway 
and on collector-distributor roadways. 

HCM Chapter 28 
Chapter 28 is the supplemental chapter for Chapter 14, Freeway Merge and Diverge Segments, which is found in 
Volume 2 of the Highway Capacity Manual (HCM). The chapter provides example problems for demonstrating the 
application of Chapter 14 methodology and its extension to freeway managed lanes. 

Operational Data 
Project Properties 

The following inputs are general information involving the analysis and are available under the Project Properties 
section: Analyst, Jurisdiction, Agency, Time Analyzed, Analysis Year, Date, and Project Description. A checkbox 
for Design Analysis is provided. When checked, a table will be added to both the formatted and text reports, listing 
the results for the current freeway segment with different numbers of lanes. A checkbox for Service Volumes is also 
provided. Checking this will enable the D-factor and K-factor fields and will add service volume tables to the end of 
both the formatted and text reports. 

 

Geometric Data 

For merge and diverge segments, inputs are separated with freeway data on the left and ramp data on the right. 
Both the freeway and ramp data require Number of Lanes, Free Flow Speed, Terrain Type, and Percent Grade and 
Grade Length if Terrain Type is Specific Grade. 

Data specifically for ramps include the acceleration/deceleration lane lengths and the side of junction or location of 
ramp. Data specifically for the freeway include the freeway length and indication if it is a Highway or C-D Roadway. 

There is also a checkbox to indicate the presence of a Managed Lane. When ‘Managed Lane’ is checked, three 
new sections are added to the bottom of the input screen: Managed Lane Geometric Data, Managed Lane Demand 
Data, and Managed Lane Adjustment Factors. Inputs for Managed Lane Geometric Data include: Number of 
Managed Lanes, Managed Lane Type, Free-Flow Speed of the Managed Lane, Terrain Type, and Percent Grade 
and Grade Length if the Terrain Type is Specific Grade. Inputs for Managed Lane Demand Data include: Managed 
Lane Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-Trailers. 
Inputs for Managed Lane Adjustment Factors include: Driver Population, Demand Adjustment Factor, Speed 
Adjustment Factor, and Capacity Adjustment Factor. 
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For an individual diverge segment, a checkbox for Major Diverge is provided when the number of ramp lanes is 2. 
This checkbox is hidden when the number of ramp lanes is 1. 

 

Demand Data 

Demand, Peak Hour Factor, Percent Total Trucks, Percent Single-Unit Trucks, and Percent Tractor-Trailers are 
necessary inputs for both the subject ramp and freeway.  

 

Adjustment Factors 

Driver Population and Weather Type are also taken into account and inputs are provided for both the ramp and the 
freeway. These fields affect the Speed and Capacity Adjustment Factors. However, if the user chooses to override 
the default values based on driver population and weather type, they can change the adjustment factors. In addition 
to these inputs, there are inputs for Demand Adjustment Factor and Incident Type. 

 

Adjacent Ramps 

Fields are provided for adjacent ramps if they exist in an analysis. This section is only enabled when Number of 
Freeway Lanes is 3. There are inputs for both upstream and downstream adjacent ramps; the user can specify if 
the adjacent ramp is a merge or a diverge, the distance from the subject ramp to the adjacent ramp, the Terrain of 
the adjacent ramp, the Demand of the adjacent ramp, the Peak Hour Factor of the adjacent ramp, and the Percent 
Trucks of the adjacent ramp. 

 

Results 

LOS criteria applies to all ramp-freeway junctions and may also be applied to major merges and diverges; high-
speed, uncontrolled merge or diverge ramps on multilane highway sections; and merges and diverges on freeway 
C-D roadways. LOS is not defined for ramp roadways. 

Level of Service (LOS) Criteria for Freeway Merge and Diverge Segments: 
  Density (pc/mi/ln) [USC]  Density (pc/km/ln) [SI] 
LOS A  ≤10      ≤6 
LOS B  >10 - 20   >6 – 12 
LOS C  >20 - 28   >12 – 17 
LOS D  >28 - 35   >17 – 22 
LOS E  >35    >22 
LOS F  v/c>1.0    v/c>1.0 

Design Analysis 
The design mode of HCS Freeways can be used to determine the number of lanes required for a particular target 
LOS. Simply select the ‘Design Analysis’ checkbox and a table will be added to the report, listing the density and 
LOS for each number of lanes (2-5 for Basic and Ramp segments, and 3-6 for Weaving segments). For ramp 
segments, both 1 ramp lane and 2 ramp lanes are evaluated. 

Merge Report 
The report can be displayed in either Page or Full View. If displayed in Page View, the results will automatically 
update when the user switches to the Report page. From the Report page, the user can switch between the 
formatted report and text report using the button found at the bottom of the page. The formatted report shows the 
most important results in a presentable format, while the text report shows a detailed step-by-step analysis in plain 
text.
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If displayed in Full View, the report can be displayed along with the input screen. The user has the choice of 
displaying the report to the right of the input screen or below the input screen. The report is dynamic and reacts to 
changes in the input screen. Like the Report page in Page View, the user can switch between the formatted report 
and the text report using the button found at the bottom of the report. 

All or a portion can be copied to the Windows clipboard for insertion into other files by right-clicking into the report 
and selecting Copy. The user can also change the display of the report through File Menu or with the user of 
shortcuts. See General Controls. 

Diverge Report 
The report can be displayed in either Page or Full View. If displayed in Page View, the results will automatically 
update when the user switches to the Report page. From the Report page, the user can switch between the 
formatted report and text report using the button found at the bottom of the page. The formatted report shows the 
most important results in a presentable format, while the text report shows a detailed step-by-step analysis in plain 
text. 

If displayed in Full View, the report can be displayed along with the input screen. The user has the choice of 
displaying the report to the right of the input screen or below the input screen. The report is dynamic and reacts to 
changes in the input screen. Like the Report page in Page View, the user can switch between the formatted report 
and the text report using the button found at the bottom of the report. 

All or a portion can be copied to the Windows clipboard for insertion into other files by right-clicking into the report 
and selecting Copy. The user can also change the display of the report through File Menu or with the user of 
shortcuts. See General Controls. 
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Freeway Reliability 

HCM Chapter 11 
The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity 
Manual (HCM) for analyzing a freeway’s travel time reliability over a multiday or multimonth reliability reporting 
period (RRP). The methodology estimates the impacts of recurring and non-recurring congestions (i.e., demand 
variations and fluctuations, incidents, weather, work zones, and special events) on the travel time distribution over 
the course of the RRP. As an extension, the methodology can be used to estimate the impacts of Active Traffic and 
Demand Management (ATDM) strategies on the travel time distribution. 

This chapter’s methodology relies on the freeway facilities core methodology presented in Chapter 10, which in turn 
applies the freeway segment methodologies in Chapters 12, 13, and 14. The freeway facilities core methodology 
focuses the analysis on a single day or less, while the segment methodologies are limited to the analysis of one 15-
min period. In contrast, this chapter’s methodology is capable of repeatedly applying the core method across 
multiple days, weeks, months, up to a one-year RRP. A one-year RRP is the most common application, although 
shorter periods are possible for specific applications (e.g., reliability of summer tourist traffic, a focus on the 
construction season). RRPs longer than one year are uncommon, as most typical variations in travel time (day-of-
week, month-of-year, weather, and incidents) are encapsulated in a single year. 

 

STRENGTHS OF THE METHODOLOGY 

The methodology is capable of estimating the impacts of non-recurring congestion (due to demand variability, 
weather, incidents, work zones, and special events) on the operational performance of a freeway facility over an 
extended reliability reporting period—up to one year. Due to the computational efficiency of the HCM freeway facility 
core methodology, compared to an analysis of a freeway facility in simulation, for example, a whole-year analysis 
can be performed relatively quickly. Specific strengths of the methodology are: 

 An efficient method to estimate travel time reliability, which can be applied quickly several hundred times 
to derive a travel time distribution over a reliability reporting period up to one year. 

 A core methodology that is less computationally intensive than microsimulation. 

 A core methodology that can be directly calibrated on the basis of local or regional capacity defaults to 
replicate recurring bottlenecks. 

 The consideration of local and regional weather defaults for the 101 largest U.S. metropolitan areas based 
on a ten-year average. 

 A method to estimate incident and crash rates in the absence of detailed local incident logs. 

 The ability to extend the method for evaluating ATDM strategies. 
In addition, the strength of the core methodology described in HCM Chapter 10 also apply to the reliability and 
strategy assessment methods presented here. 
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LIMITATIONS OF THE METHODOLOGY 

Because the reliability method applies the freeway facility core methodology multiple times, it inherits the core 
methodology’s limitations. These limitations were described in HCM Chapter 10. For example, one limitation of the 
core method is its use of 15-min analysis periods. Therefore, all event durations (e.g., weather, incidents) used by 
the reliability method must be expressed as integer numbers of 15-min analysis periods. The reliability method has 
the following additional limitations: 

 The method assumes a multiplicative effect when two or more factors (weather and incident) affect speed 
or capacity. This assumption has not been sufficiently tested empirically, and may overstate the deleterious 
effects of combined non-recurring congestion effects. 

 Weather events that have a small effect (<4%) on segment capacity reduction are not addressed. A given 
weather event (e.g., rain, snow) is always assumed to occur at its mean duration value. Sun glare is not 
accounted for. 

 The method assumes that incident occurrence and traffic demand are independent of weather conditions, 
although all are indirectly tied to each other through the specification of demand, incident, and weather 
probabilities on a calendar basis. However, the analyst is able to adjust incident frequencies by month on 
the basis of local data. 

 The method estimates incident occurrence as a function of segment demand and month of the year. It does 
not consider potentially elevated incident rates in segments with low demands. Some segments may be 
overly prone to incidents due to poor visibility, poor geometry, a short weaving segment, or a host of other 
factors that are not considered by the reliability method. 

 The method does not consider full facility closures in the scenarios. In the course of assigning incidents to 
the segments, at least one lane should therefore remain open. The scenario generation methodology does 
not assign incidents that result in full-segment closure, but reassigns those probabilities to other (less 
severe) incidents. This is also true for work zones, where at least one travel lane has to remain open. 

 The travel time reliability analysis assumes similar effects of demand variation and weather conditions on 
general purpose and managed lanes, when a managed lane facility is included in the analysis. 

 Work-zone events are only allowed to be modeled in general purpose lanes; no managed-lane work zone 
effects are considered. 

 The traffic-demand adjustment assumes a proportional demand effect across the entire facility, meaning 
that all inputs and outputs (across time and space in the base scenario) are increased or decreased by the 
same factors. 

 

CALIBRATION AT THE TRAVEL TIME RELIABILITY LEVEL 

After calibrating the core freeway facility methodology and fixing the value of its parameters, a comprehensive travel 
time reliability calibration is performed. The process includes three major steps: whole-year demand calibration, 
incident calibration, and weather calibration.  

To calibrate the methodology for a particular site, it is recommended that the analyst perform an initial 
comprehensive reliability run using default values for all input parameters and subsequently compare the predicted 
travel time index (TTI) cumulative distribution to the observed distribution.  

The comprehensive reliability calibration steps include: 

 Step 1: Gather input data (demand, weather, incident, distribution, and work zone data 

 Step 2: Determine demand multipliers 

 Step 3: Calibrate incident probabilities 

 Step 4: Calibrate weather probabilities 

 Step 5: Validate parameters 
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Operational Data 
BASE 

On the Base page, the user is required to load a base dataset to run a Freeways Reliability analysis. There are two 
options when using a base dataset: Load Base Dataset and Create Base Dataset. The program requires the HCS 
Freeways module for both these options. The Load Base Dataset button opens a dialog that allows users to open 
an existing HCS Freeways (*.xuf) file. The Create Base Dataset button launches the Freeways module where a 
user can create a new HCS Freeways (*.xuf) file. If HCS is already installed on the computer, then the Freeways 
module should open when this button is clicked. If HCS is not installed, an error will popup and HCS will need to be 
installed on the computer to continue with the Freeway Reliability analysis. 

The Base page shows a summary of the data from the Freeways file. When a Freeways file is loaded, the required 
information from the dataset is extracted for reliability analysis. Two sections appear when the Freeways file is 
loaded: Base Dataset Facility and Base Dataset General Information. The number of segments in the facility, along 
with the segment type, segment length, and number of lanes on each segment are displayed graphically in the first 
section. The second section lists out the Analyst Name, Agency, Jurisdiction, Year, Date, File Name, and Project 
Description taken directly from the Freeways file. 

 

ANALYSIS 

On the Analysis page, there are fields for the user to specify project properties. These include: Analyst, Agency, 
Analysis Year, Jurisdiction, Time Analyzed, Date, and Project Description. The Analysis page is further used to 
specify the duration of the reliability reporting period. There are three main sections in the analysis page: Reporting 
Period, Study Period, and Number of Replications. 

The reliability reporting period represents the specific days over which the travel time distribution it to be computed, 
for example, all nonholiday weekdays in a year. The period is specified by start and end dates as well as by the 
days of week being considered. The start and end dates can be selected by clicking the calendar in the respective 
textbox and selecting the date on the calendar or by typing the date in the format MM/DD/YYYY. The days of week 
to be considered in a reliability analysis can be selected by clicking the checkboxes provided for each day of the 
week. 

If these values are not changed by the user, the following defaults will be used: 

 Start Date: Today’s date 

 End Date: Today’s date, a year later 

 Days of Week: Mon, Tue, Wed, Thu, Fri (all weekdays) 
The number of days should be reflected under each month based on the information input for reporting period. The 
reliability reporting period is used with the study period to describe the temporal representation of the performance 
measure fully (e.g., average travel time on nonholiday weekdays from 4:00 to 6:00 p.m. for the current year). 

The Study Period is based on information pulled from the Freeways Base Dataset. Listed in the Study Period box 
is the Start Time, End Time, and Duration (min).  

The user can specify the number of times the methodology is applied changing the Number of Replications. For a 
one-year reliability reporting period, the methodology is typically applied with four replications for each of five 
weekdays (Monday through Friday) and 12 months in the year, for a total of 240 scenarios. This approach roughly 
corresponds to 250 work days in a typical calendar year. A reliability analysis that includes weekend effects would 
result in an increased number of scenarios. For reliability reporting periods that are significantly shorter than one 
year, the analyst should increase the number of replications to ensure a sufficient sample size for scenario 
generation. HCM Exhibit 11-9, found below, provides guidance on the recommended number of replications in such 
cases. 
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WEATHER 

On the Weather page, a drop-down list is located at the top of the screen where a city with available weather data 
can be chosen. A city can also be typed into the search bar, which will then match and select the city from the drop 
down list. 

Once a city is selected, the first table displayed will show the defaults of Weather Event Probability and Weather 
Event Duration. The probability of a weather event happening is displayed for each month based on the location 
and the study period start time and end time. The default probabilities are based on the Metropolitan Weather 
Database for Freeway Reliability Analysis in Volume 4 of the HCM. The duration associated with each weather 
even is the length of time of the weather event in minutes. The default duration for each weather event is the same 
for each location. If any of the probability defaults or duration is changed, the weather location originally selected 
will change to ‘Custom’. To restore the default values, the user can set the location again. 

Based on weather conditions and free-flow speeds, the second table displayed shows the Demand Adjustment 
Factors, Capacity Adjustment Factors, or Speed Adjustment Factors by switching between the DAF, CAF, and SAF 
tabs. Demand Adjustment Factor default values are 1.000 for all. Capacity Adjustment Factor and Speed 
Adjustment Factor default values can be found in the tables below. 

Default CAFs by Weather Condition: 
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Default SAFs by Weather Condition: 

 

 

DEMAND 

The Demand page is used to display user inputs related to demand to specify demand ratios. 

One of the required inputs is the Freeway Area Type. There are two freeway area types considered: Urban Freeway 
and Rural Freeway. The default in the program is Urban Freeway. Once selected, the defaults for Default Freeway 
Demand Ratios and Demand Ratios Relative To Base Dataset are displayed. Similar to the table on the Weather 
page, the fields in the Default Freeway Demand Ratios table can be edited if necessary. The ratios were derived 
from a national freeway dataset developed by SHRP 2 Project L03. All ratios reflect demand relative to a Monday 
in January. Where possible, analysts should obtain local or regional estimates of demand variability to account for 
facility-specific and seasonal trends on the subject facility. 

Default Urban Freeway Demand Ratios (ADT/Mondays in January): 
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Default Rural Freeway Demand Ratios (ADT/Mondays in January): 

 

The Demand Ratios Relative To Base Dataset table displays the demand ratios relative to the base dataset. The 
values in the Default Freeway Demand Ratios table can be edited, if necessary, and the corresponding values in 
the Demand Ratios Relative To Base Dataset table will change based on the edited values. 

 

INCIDENT 

The Incident page is used to display user inputs related to incident and crash frequency data, distribution and 
duration, and adjustment factors based on incident type. 

Incidents are generated on the basis of their expected frequency of occurrence per study period (analysis hours in 
a day) in a given month on the facility. The analyst may opt to use default expected incident frequencies, may supply 
a facility-specific incident or crash rate, or may supply a 12-month table of facility-specific expected frequencies of 
any incident type. 

The first table displayed on the Incident page is the incident distribution and duration. It provides mean distributions 
of freeway incidents by severity and default incident duration parameters by incident type. 

 

The second table displayed on the incident page can display either values for Demand Adjustment Factor (DAF), 
Capacity Adjustment Factor (CAF), or Speed Adjustment Factor (SAF) by clicking on the corresponding tabs. The 
defaults for DAF and SAF are 1.000 for all incident severities. The table below shows the default CAFs associated 
with each incident severity. The values shown in the table reflect the remaining relative capacity per open lane. For 
example, a two-lane closure incident on a six-lane directional facility (underscored) results in a loss of two full-lane 
capacities, in addition to maintaining only 75% of the remaining four open lanes’ capacities. The result is that only 
three lanes worth (50%) of the facility’s original six lane capacity is maintained. No information is currently available 
on the effect of incidents on free-flow speed, so this effect is not accounted for at this time. 



____________________________________________________________________________________________________ 
 Freeways User Guide    Freeway Reliability · 33 

 

Incident Frequency Data is also provided, with three choices: Local Incident Frequency, Local Crash Frequency, 
and Calculated Crash Frequency. Choosing Local Incident Frequency will enable a table with fields for Incident 
Frequency (per 100 million VMT) that by month. Defaults are provided but can be edited if the user is aware of 
recurring incident occurrences. If, for example, incidents are more likely in winter months (despite potentially lower 
demands), the user should adjust the incident rate defaults and calibrate for local conditions. Choosing Local Crash 
Frequency will enable a table with defaults for Crash Frequency (per 100 million VMT) that vary by month. Similar 
to Local Incident Frequency, the values are editable for the user to calibrate for local conditions. In addition to this 
table, a field is provided for the user to specify the Incident-to-Crash Ratio (ICR). Choosing Calculated Crash 
Frequency will cause the Highway Economic Requirements System (HERS) model to be used to calculated crash 
rate. Fields for ICR, ACR, and Lane Width will also be provided for the user to specify. 

 

WORK ZONE 

The Work Zone page is used to add scheduled work zones to the analysis. The user can add work zone events by 
clicking the ‘Add Work Zone Event’ button. If there are already work zone events present in a dataset, the user can 
add more by using either the ‘Add Work Zone Event’ button or the ‘Insert Work Zone Event’ button. When the ‘Add 
Work Zone Event’ button is used, a new work zone event will be added to the end of the list of work zone events. 
When the ‘Insert Work Zone Event’ button is used, a new work zone will be added before the work zone event that 
is currently selected in the list of work zone events. To delete work zone events, the user can select one or more 
work zone events and then click the ‘Delete Work Zone Event‘ button.  

When a work zone event is added, the following inputs are provided for the user to change: Segment ID, Start Date, 
End Date, Start Analysis Period, Duration Analysis Period, Lane Closure Type, Barrier Type, Area Type, Lateral 
Distance, Daylight or Night, Speed Limit, and Percent Drop in Capacity. Segment ID allows the user to specify 
which segment in the analysis is affected by a work zone. Start Date and End Date provides the date boundaries 
for when the work zone event takes place. Start Analysis Period provides a drop down menu for the user to select 
between the analysis periods set from the base dataset. Duration Analysis Period specifies how many analysis 
periods the work zone event lasts. Based on the geometry of the facility being analyzed, Lane Closure Type can 
have up to five options: Shoulder Closed, 1 Lane Closed, 2 Lanes Closed, 3 Lanes Closed, and 4 Lanes Closed. 
Barrier Type has two options: Hard Barrier Separation and Soft Barrier Separation. Area Type also has two options: 
urban areas and rural areas. Urban area are typified by high development densities or concentrations of population. 
Rural areas are areas with widely scattered development and low housing and employment densities. Lateral 
distance is specified in feet and is the distance from the edge of the travel lane adjacent to the work zone to the 
barrier, barricades, or cones. Daylight or Night is used to determine whether daytime or nighttime operations are 
considered. Speed Limit is used to specify the speed limit, in miles per hour, of the work zone. Higher work zone 
speed limits and higher speed ratios result in higher work zone FFS. Percent Drop in Capacity refers to the 
percentage drop in pre-breakdown capacity at the work zone due to queuing conditions. Research shows an 
average queue discharge drop of 7% in non-work zone conditions, and an average value of 13.4% in freeway work 
zones.  
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SPECIAL EVENT 

The Special Event page is used to add special events, such as football games or concerts, to the analysis. The 
user can add special events by clicking the ‘Add Special Event’ button. When the ‘Add Special Event’ button is 
used, a new special event will be added to the end of the list of special events. A textbox for ‘Scenario ID for Special 
Event’ is provided for the user to enter the appropriate scenario for the special event to be added. To delete special 
events, the user can select one or more special events and then click the ‘Delete Special Event’ button. 

When a special event is added, a row of the following inputs/information are included: Scenario ID, Analysis Period, 
Demand Ratio, Weather Event Count, Incident Event Count, Work Zone Event Count, Import from XUF File, and 
Overwritten by Imported File. 

 

EVENTS 

The Events page lays out the events found in each of the scenarios generated from the reliability analysis. There 
are three tabs to choose what is displayed on the page. These include: Summary, Incident, and Work Zone. The 
Summary tab displays the Scenario ID, Analysis Period, Demand Ratio, Weather Event Count, Incident Event 
Count, and Work Zone Event Count. The Incident tab displays the Event ID, Incident Event Type, Scenario ID, 
Segment ID, Start Analysis Period, and Duration (Analysis Periods). The Work Zone tab displays the Segment ID, 
Start Date, End Date, Lane Closure Type, and Assigned Scenarios. All three tabs allows the user to specify how 
many items are shown per page by providing a drop-down menu in the upper left-hand corner. The user can specify 
10, 20, 50, or 100 items per page to be shown. Navigation buttons are provided below the tables to allow the user 
to easily jump between the first, previous, next, or last page of items. All three tabs also provide an ‘Export to CSV’ 
button in the upper right-hand corner. This will export the entire table of the corresponding tab to a CSV file. 

 

SUMMARY 

The Summary page provides a summary of each of the scenarios generated by the reliability analysis. The Scenario 
ID, Demand-Combination, Travel Time in minutes, Average Speed in miles per hour, and Average Density in vehicle 
per mile per lane are provided for each scenario. Similar to the Events page, a drop-down menu is provided in the 
upper left hand corner to allow the user to specify how many items to be displayed per page. Again, the choices for 
number of scenarios per page are 10, 20, 50, and 100. Navigation buttons are provided below the table to allow the 
user to easily jump between the first, previous, next, or last page of scenarios. There are also three export buttons 
provided above the table. These include: Export Summary Results to CSV, Export to XUF, and Export Facility to 
CSV. Clicking the ‘Export Summary Results to CSV’ button will allow the user to save the summary results displayed 
in the table to be saved in CSV format. ‘Export to XUF’ will allow the user to save all the scenarios generated in the 
Freeways XUF format. Clicking this button will open a dialog box allowing the user to browse folders or create a 
folder which will save a folder with all the scenarios generated. The folder holding all the scenarios will be titled the 
same as the Freeways Reliability XFR file and all the scenarios will be titled Scenario#, with # being the 
corresponding scenario number. ‘Export Facility to CSV’ will export the inputs of each scenario into corresponding 
CSV files. 

Freeways Reliability Report 
The Report page displays the results of the analysis in the form of tables and graphs. There are two reports available 
to the user: the formatted report and the text report. The formatted report is initially displayed, but the user can 
switch to the text report by clicking the Switch to Text Report button located at the bottom of the screen. Similarly, 
if the user has the text report displayed, the Switch to Formatted Report button located at the bottom of the screen 
can be used to display the formatted report instead. 

The report page shows a formatted version of the analysis in a dynamic form, reacting to changes in the Base, 
Analysis, Weather, Demand, Incident, and Work Zone pages. All or a portion can be copied to the Windows 
clipboard for insertion into other files by right-clicking into the report and selecting Copy. 
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The formatted report provides an overview of the results in the table. There are five sections in the table: Project 
Information, Base Dataset Analysis, Reliability Input Summary, Average Performance Measure Results, and graphs 
for TTI (TTI Probability Density Distribution and TTI Cumulative Distribution). Project Information provides 
information on the Analyst, Agency Jurisdiction, Date, Analysis Year, Time Analyzed, and Project Description. Base 
Dataset Analysis provides general information that can be found in the base dataset. These include: the base 
dataset file name, the data collection date, the start and end times of the study period, the number of analysis 
periods, and the number of segments. Reliability Input Summary provides general information on the reliability 
analysis and the random seed summary. These include: Reporting Start Date, Reporting End Date, Reliability 
Reporting Period Duration in months, Number of Days Considered, Number of Replications, Number of Scenarios, 
what is included in the Reliability analysis (Weather Events, Incident Events, Demand Ratios, and Work Zone 
Events) and the random seed numbers for Weather and Incident. Average Performance Measure Results include: 
Average Speed in miles per hour, Average Density in passenger cars per mile per lane, Average Travel Time in 
minutes, 50th Percentile Travel Time Index (TTI50), Mean Travel Time Index (TTImean), maximum observed facility 
TTI (TTImax), Misery Index, Reliability Rating as a percentage, semi-standard deviation, and Percent VMT at TTI >2. 
The four graphs at the bottom of the report show the TTI Probability Distribution Function, TTI Cumulative 
Distribution Function, Density Distribution, and Speed Distribution. 

The text report also provides the general project information and base dataset information but provides more 
Average Performance Results. These include: Average Speed in miles per hour, Average Density in both vehicles 
per mile per lane and passenger cars per mile per lane, Average Travel Time in minutes, Mean Travel Time Index 
(TTImean), 50th Percentile Travel Time Index (TTI50), 80th Percentile Travel Time Index (TTI80), Planning Time Index 
(PTI) or 95th Percentile Travel Time Index (TTI95), Maximum Observed Facility TTI (TTImax), Misery Index, Semi-
Standard Deviation, Reliability Rating as a percentage, and Percent VMT at TTI >2. 

Both formatted and text reports are available for viewing and printing.
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How To 

Create a New File 
1. From the Start screen, there are three options for creating a new file:  

 
Note: A new file can be created if an existing file is already open; you do not need to start from the Start 
screen. 
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a. Selecting File > New from the main menu; this can be found by selecting the three lines in the top 
left-hand corner of the screen, hovering over “New”, and then selecting one of the analysis types. 

 

b. Selecting “New File…” from the Start screen; this can be found below in the red box. A Select New 
File Type dialog box will pop up after selecting “New File…” which allows you to choose the desired 
analysis type.  
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c. Using the keyboard shortcut “Ctrl+N”, selecting one of the analysis types from the Select New File 
Type dialog box, and clicking “OK”  

 

2. Once a new file is created, you will be brought to the input page of the selected analysis type if in Page 
View or the input screen split with the report either on the right of the bottom of the screen if in Full View. 

a. Page View  

 

i. If Basic Freeway Segment was selected, you will be brought to the Basic page. 

ii. If Freeway Merge Segment was selected, you will be brought to the Merge page. 

iii. If Freeway Diverge Segment was selected, you will be brought to the Diverge page. 

iv. If Freeway Weaving Segment was selected, you will be brought to the Weaving page. 

v. If Freeway Facility was selected, you will be brought to the General page. 

vi. If Freeway Facility with Segmentation Tool was selected, you will be brought to the General 
page but a Segmentation window will also pop up for you to populate.  

vii. If Planning-Level Freeway Facility Analysis was selected, you will be brought to the Facility 
page.
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viii. If Freeway Reliability Analysis was selected, you will be brought to the Base page. 

b. Full View  

 

Open an Existing File 
1. From the Start screen, there are six options for opening an existing file:  

 
Note: A file can be opened even if another file is currently open; you do not need to start from the Start 
screen. 
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a. Selecting File > Open from the main menu; this can be found by selecting the three lines in the top 
left-hand corner of the screen and then selecting “Open”  

 

b. Selecting “Open File…” from the Start screen; this can be found below in the red box  

 

c. Using the keyboard shortcut “Ctrl+O” 
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d. Selecting a file under the Recent files list from the Start screen; this can be found below in the red 
box 

 

e. Selecting File > Example Folder from the main menu; this can be found by selecting the three lines 
in the top left-hand corner of the screen and then selecting “Example Folder”. Opening the example 
folder will open the path of the HCS example files in File Explorer. The desired example file can be 
double-clicked or right-clicked and selecting ‘Open’, which will open the example file in the 
Freeways program.  

 

f. Selecting “Example Folder…” from the Start screen; this can be found below in the red box. 
Opening the example folder will open the path of the HCS example files in File Explorer. The 
desired example file can be double-clicked or right-clicked and selecting ‘Open’, which will open 
the example file in the Freeways program. 
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2. Once an existing file is opened, you will be brought to the corresponding input page if in Page View or the 
input screen split with the report either on the right or the bottom of the screen if in Full View 

a. Page View  
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b. Full View  

 

Save a File 
1. There are five options for saving an open file: 

a. Selecting File > Save from the main menu; this can be found by selecting the three lines in the top 
left-hand corner of the screen and then selecting “Save”  
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b. Selecting File > Save As… from the main menu; this can be found by selecting the three lines in 
the top left-hand corner of the screen and then selecting “Save As…”  

 

c. Using the keyboard shortcut “Ctrl+S” for Save 

d. Using the keyboard shortcut “F12” for Save As 

e. Exiting the program or closing the file without saving changes beforehand; this will prompt you to 
save changes to the file before anything is closed  

 

i. Selecting “Yes” will save the file if it is an existing file. If the file has not been previously 
saved, the Save As dialog box will pop up allowing you to change the file name and save 
it. 

ii. Selecting “No” will exit the program or close the file without saving the file 

iii. Selecting “Cancel” will not save the file and prevent the file from closing 

Note: Using Save with an existing file will save a file without prompting you to specify a file name. Using Save with 
a new file will bring up the Save As dialog box for you to specify a file name for saving. Using Save As will always 
bring up the Save As dialog box for you to specify a file name for saving. 
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Close a File 
1. There are three options for closing an open file: 

a. Selecting File > Close from the main menu; this can be found by selecting the three lines in the top 
left-hand corner of the screen and then selecting “Close”  

 

b. Using the keyboard shortcut “Ctrl+W” 

c. Exiting the program itself; please see How To: Exit the Program 

Exit the Program 
1. From the Start screen, there are three options for exiting the program:  

 
Note: The program can be exited even if a file is still open; you do not need to start from the Start screen. 
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a. Selecting File > Exit from the main menu; this can be found by selecting the three lines in the top 
left-hand corner of the screen and then selecting “Exit”  

 

b. Using the keyboard shortcut “Alt+F4” 

c. Selecting “X” in the top right-hand corner of the screen; this can be found below in the red box. 
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Edit the Default Settings 
1. From the Start screen, there are two options for editing the Default Settings:  

 
Note: The Default Settings can be changed even if an existing file is already open; you do not need to start 
from the Start screen.  

a. Selecting File > Default Settings from the main menu; this can be found by selecting the three lines 
in the top left-hand corner of the screen and then selecting “Default Settings”  

 

b. Using the keyboard shortcut “Alt+F4” 
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2. Opening the Default Settings will cause a Default Settings window to pop up:  

 

3. Settings 

a. You can specify Analyst, Agency, and Jurisdiction by clicking in the corresponding text boxes and 
typing the desired text.  

b. Under ‘Units’, you are given the option of running the analysis in either U.S. Customary (USC) or 
SI (Metric) units. 

c. Under ‘Export to CSV’, three checkboxes are provided to indicate what to include when exporting 
to CSV.  
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i. Export Output: If this is checked, the output results will be exported along with the input. 

 

ii. Descending Order (not allowed to be imported): If this is checked, segments will be 
exported in descending order instead of ascending order (i.e., an analysis with 11 
segments will show the segment data starting from segment number 11 and ending with 
segment data for segment number 1). Note: If the exported CSV file is later used for import, 
the Freeways program will not allow it to be imported. The CSV file must have data in 
ascending order for it to be imported.  

 

iii. Export Oversaturated Results (if available): If this is checked, oversaturated results will be 
exported along with the input if the analysis uses the oversaturated procedure. The 
exported oversaturated results will be exported in a separate CSV file from the exported 
inputs CSV file. The default name for the exported oversaturated results file is ‘export-
OversaturatedIntermediateResults.csv’. 
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d. Under ‘Reports’, three checkboxes are provided to indicate what to show in the formatted reports 
of facility analyses. 

i. Messages: If this is checked, any messages displayed in the Information window will also 
be displayed on the facility formatted report.  
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ii. Charts: If this is checked, the Volume Distribution, Speed Distribution, and Density 
Distribution charts will be displayed on the facility formatted report.  

 



____________________________________________________________________________________________________ 
 52 · How To     Freeways User Guide 

iii. Graphs: If this is checked, the facility heat map graphs for each analysis period for Flow 
Rate, Speed, Density, and LOS will be displayed on the facility formatted report. 

  

e. Clicking “OK” will save the changes made and close the Default Settings window; clicking “Cancel” 
will close the Default Settings window without saving any changes 

f. When a new file is created, the Analyst, Agency, and Jurisdiction fields will automatically be 
populated with the text specified in the Default Settings. 

g. When starting a new file, the input and results will display according to the units specified in the 
Default Settings. 

h. When exporting to CSV, whatever is checked in the Default Settings will be applied to the exported 
file. 

i. When viewing the facility formatted report, whatever is checked in the Default Settings will be 
applied to the report.  
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Change the View 
1. When a file is open, there are three main options for the view of the program: 

a. Page View: the inputs and results reports are separated into pages as seen below. You can 
navigate between pages using the “Back” and “Next” buttons or by clicking the page names found 
at the top of the screen. Note: Page View is available for both single segment and facility analyses. 

 

b. Full View with the report on the right of the screen: the screen is split with all inputs on the left side 
and the results reports on the right side. You can access all inputs and view all of the current report 
by using the corresponding scroll bars. There is also a screen splitter that can be moved to adjust 
the view of the input screen and results report.  
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c. Full View with the report on the bottom of the screen: the screen is split with all inputs on the top of 
the screen and the results reports on the bottom of the screen. You can access all inputs and view 
all of the current report by using the corresponding scroll bars. There is also a screen splitter that 
can be moved to adjust the view of the input screen and results report. Note: Full View with the 
report on the bottom is only available for single segment analyses.  

 

2. Views can be changed by using the main menu items or the keyboard shortcuts. 

a. Main Menu Items 

i. To switch to Page View, select File > View > Page View from the main menu; this can be 
found by selecting the three lines in the top left-hand corner of the screen, hovering over 
“View”, and then selecting “Page View”  
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ii. To switch to Full View with the report on the right of the screen, select File > View > Full 
View > Report -> Right from the main menu; this can be found by selecting the three lines 
in the top left-hand corner of the screen, hovering over “View”, hovering over “Full View”, 
and then selecting “Report -> Right”.  

 

iii. To switch to Full View with the report on the bottom of the screen, select File > View > Full 
View > Report -> Bottom from the main menu; this can be found by selecting the three 
lines in the top left-hand corner of the screen, hovering over “View”, hovering over “Full 
View”, and then selecting “Report -> Bottom”.  

 

Note: This is only available for single segment analyses; it is not available for facility 
analyses.  

b. Keyboard Shortcuts 

i. Page View: keyboard shortcut is “F9” 

ii. Full View with report on the right of the screen: keyboard shortcut is “F10” 

iii. Full View with report on the bottom of the screen: keyboard shortcut is “F11” 
Note: This is only applicable for single segment analyses; it does not apply to facility 
analyses.  
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Model a Freeway Facility by Segmentation 
1. Segmentation allows the user to quickly model a freeway facility by providing the locations of ramp gore 

points, while HCS applies the HCM guidance to determine segment lengths in between the ramps. 

2. When automatic segmentation is chosen, HCS will display the following pop-up window with initially one 
section. 

 

3. Clicking the “Add Section” button will add one ramp and one freeway section to the facility. 

 

4. A weaving segment can be modeled by adding one On-Ramp and one Off-Ramp consecutively while also 
making sure the freeway section in between the ramps has one more lane than the adjacent sections. 

 

a. When a weaving segment is added, up to 1000 feet will be added to the segment length (500 feet 
upstream and 500 feet downstream if length is available) according to the segmentation criteria 
set in the Highway Capacity Manual. 



____________________________________________________________________________________________________ 
 Freeways User Guide    How To · 57 

5. If segmentation between consecutive basic segments is required (e.g., due to a change in number of 
lanes), select the subject section and click the “Insert Section” button to add additional sections. 

 

6. Click the “OK” button when finished. The automatic segmentation will overwrite any freeway facility model 
previously developed, as shown in the pop-up window. 

 

Import 
1. When there is a facility analysis open, there is only one option for import: Import from CSV  

a. A CSV file (*.csv) with all the necessary labels and identifiers in brackets is required for importing. 

b. Before importing, the facility analysis open in HCS Freeways must have the same number of 
segments and number of analysis periods as the CSV file to be imported. If it does not, the CSV 
file cannot be imported and Freeways will give an error. Please see Freeway Facilities: 
Import/Export Facility for more detailed information. 

c. The imported CSV file also cannot be in descending order. Please see How To: Edit the Default 
Settings for more detailed information. 

d. To import data from a CSV file, select File > Import From CSV from the main menu; this can be 
found by selecting the three lines in the top left-hand corner of the screen and then selecting “Import 
from CSV”. 
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e. Note: The import function is only applicable for facility analyses; they do not apply to single segment 
analyses. The File > Import From CSV menu item will only be enabled for facility analyses; it will 
be disabled for single segment analyses. 

Export 
1. When there is a facility analysis open, there are two options for export: Facility to CSV and Facility to Graph 

a. To export facility data to a CSV file, select File > Export > Facility -> CSV from the main menu; this 
can be found by selecting the three lines in the top left-hand corner of the screen, hovering over 
“Export”, and then selecting “Facility -> CSV”. 

 

b. To export the facility graph to an image file (*.png), select File > Export > Facility -> Graph from the 
main menu; this can be found by selecting the three lines in the top left-hand corner of the screen, 
hovering over “Export”, and then selecting “Facility -> Graph”. 
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c. Note: The export functions are only applicable for facility analyses; they do not apply to single 
segment analyses. The File > Export > Facility -> CSV and File > Export > Facility -> Graph menu 
items will only be enabled for facility analyses; it will be disabled for single segment analyses. 

2. Export Facility to CSV 

a. When a facility is exported to a CSV file, a Save As dialog box will pop up allowing you to specify 
a name for saving the HCS CSV file (*.csv). Note: The default CSV file name is export.csv but can 
be overwritten.  
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b. Once a file name is specified, click the Save button.  

 

c. The CSV file of the facility data will be saved in the folder you specified when saving.  
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d. If you open the exported CSV file, the default program for CSV files will open.  

 

e. All data from the Freeways facility file (*.xuf) will be displayed in the CSV file. The first value of each 
line consists of the input label along with identifiers in brackets. Please see Freeway Facilities: 
Import/Export Facility for more detailed information. 

f. The data in the CSV file and how it is displayed is also dependent on the settings specified in the 
Defaults Settings. Please see How To: Edit the Default Settings for more detailed information. 

3. Export Facility to Graph 

a. When a facility is exported to a graph, a Save As dialog box will pop up allowing you to specify a 
name for saving the image file (*.png;).  
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b. Once a file name is specified, click the Save button.  

 

c. The image of the facility displayed on the Details or Results page will be saved in the folder you 
specified when saving.  
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Run a Reliability Analysis 
1. To run a reliability analysis, select File > Reliability Analysis from the main menu; this can be found by 

selecting the three lines in the top left-hand corner of the screen and then selecting “Reliability Analysis”. 
Note: A file must be open to run a reliability analysis.  

 

2. Running a Reliability analysis from within HCS Freeways will bring you to the Base page for a Freeways 
Reliability analysis with the Base Dataset already loaded with the file open in Freeways.  

 

3. All other inputs will need to be specified for running the reliability analysis. Please see the Freeways 
Reliability User Guide for more detailed information. 
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View Results of the Analysis 
1. After editing all the necessary inputs, results of the analysis can be found in the form of pages for facility 

analyses, and in the form of reports for both single segment and facility analyses. Reports can be found on 
the Report page if using Page View or on the results portion of the split screen if using Full View. 

2. There are two options for pages: Results and Report 

a. The Results page is only available for facility analyses. On the Results page, Segment Data, 
Geometric Data, Demand and Capacity, and Speed and Density sections are provided for each 
individual segment. Additional sections may be available depending on the segment type or other 
special cases within the analysis.   

 

i. Under the Segment Data, you can specify which segment within the facility to display by 
selecting the segment number in the drop down menu or selecting the specific segment in 
the Segment graph. The analysis period can also be specified by selecting it in the 
corresponding drop down menu.  
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ii. The Segment graph also gives options to display the facility for the current analysis period 
by color coding the facility graph based on a selected performance measure.  

 

iii. If the oversaturated procedure is being used, a note will be displayed at the bottom of the 
Results page.  

 

b. The Report page can display a single segment formatted report, single segment text report, facility 
formatted report, facility text report, or heat map report. Reports available are dependent on the 
current analysis.  
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3. There are three options for reports: Formatted, Text, and Heat Map 

a. Formatted reports show the most important results in a presentable format  

 

b. Text reports show a more detailed analysis in plain text  
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c. Heat Map reports show a graphical representation of data where the individual values contained in 
a matrix are represented as colors. Note: Heat Map reports are only available for facility analyses.  

 

4. The type of report displayed can be changed by using the main menu items, keyboard shortcuts, or toggle 
buttons found under the report 

a. Main Menu Items 

i. To switch to the Formatted Report, select File > Report > Formatted Report from the main 
menu; this can be found by selecting the three lines in the top left-hand corner of the 
screen, hovering over “Report”, and then selecting “Formatted Report”.  
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ii. To switch to the Text Report, select File > Report > Text Report from the main menu; this 
can be found by selecting the three lines in the top left-hand corner of the screen, hovering 
over “Report”, and then selecting “Text Report”.  

 

iii. To switch to the Heat Map Report, select File > Report > Heat Map Report from the main 
menu; this can be found by selecting the three lines in the top left-hand corner of the 
screen, hovering over “Report”, and then selecting “Heat Map Report”. Note: Heat Map 
Report is only available for facility analyses. The menu item is removed when the current 
analysis is a single segment analysis.  

 

b. Keyboard Shortcuts 

i. Formatted Report: keyboard shortcut is “F4” 

ii. Text Report: keyboard shortcut is “F6” 

iii. Heat Map Report: keyboard shortcut is “F7”; Note: Heat Map Report is only available for 
facility analyses. The keyboard shortcut does not work when the current analysis is a single 
segment analysis. 
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c. Report Toggle Buttons 

i. Whether viewing the report in Page View or Full View, a toggle button(s) will be available 
at the bottom of the screen underneath the report. 

ii. If a single segment analysis is the current analysis and the formatted report is currently 
being displayed, one toggle button will be displayed and will say “Switch to Text Report” 
which will allow you to display the text report if clicked.  

 

iii. If a single segment analysis is the current analysis and the text report is currently being 
displayed, one toggle button will be displayed and will say “Switch to Formatted Report” 
which will allow you to display the formatted report if clicked.  
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iv. If a facility analysis is the current analysis and the facility formatted report is currently being 
displayed, three toggle buttons will be displayed.   

 

1. One button will say “Switch to Text Report” which will allow you to display the 
facility text report if clicked.  

2. The second button will say “Switch to Segment Report” which will allow you to 
display the single segment formatted report if clicked. It will also bring up two drop 
down menus; one for Segment and one for Analysis Period. This will allow you to 
display the report for specific segments within the facility and for specific analysis 
periods.  

3. The last button will say “Heat Map Report” which will allow you to display the facility 
heat map report if clicked. This will add a drop down menu for Additional Tables 
which will allow you to add more heat map tables for different performance 
measures to display. A ‘Show Detailed Heat Map’ checkbox will also be available 
to specify if a detailed heat map is desired. When checked, values will be shown 
in each individual cell. When unchecked, a legend will be provided and each of the 
heat map tables will only show colored cells without values inside. 

v. If a facility analysis is the current analysis and the facility text report is currently being 
displayed, three toggle buttons will be displayed.   
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1. One button will say “Switch to Formatted Report” which will allow you to display 
the facility formatted report if clicked.  

2. The second button will say “Switch to Segment Report” which will allow you to 
display the single segment text report if clicked. It will also bring up two drop down 
menus; one for Segment and one for Analysis Period. This will allow you to display 
the report for specific segments within the facility and for specific analysis periods.  

3. The last button will say “Heat Map Report” which will allow you to display the facility 
heat map report if clicked. This will add a drop down menu for Additional Tables 
which will allow you to add more heat map tables for different performance 
measures to display. A ‘Show Detailed Heat Map’ checkbox will also be available 
to specify if a detailed heat map is desired. When checked, values will be shown 
in each individual cell. When unchecked, a legend will be provided and each of the 
heat map tables will only show colored cells without values inside. 

vi. If a facility analysis is the current analysis and the segment formatted report is currently 
being displayed, three toggle buttons along with two drop down menus and an ‘All 
Segment’ checkbox will be displayed. The two drop down menus allow you to specify the 
specific segment within the facility and specific analysis period to display in the current 
report. The ‘All Segments’ checkbox allows you to display the individual segment reports 
for all segments within the facility.   

 

1. One button will say “Switch to Text Report” which will allow you to display the 
segment text report if clicked. This will also remove the ‘All Segments’ checkbox.  

2. The second button will say “Switch to Facility Report” which will allow you to display 
the facility formatted report if clicked. This will also remove the two drop down 
menus and checkbox.  

3. The last button will say “Heat Map Report” which will allow you to display the facility 
heat map report if clicked. This will remove the two drop down menus and 
checkbox; however, it will add another drop down menu for Additional Tables 
which will allow you to add more heat map tables for different performance 
measures to the display. A ‘Show Detailed Heat Map’ checkbox will also be 
available to specify if a detailed heat map is desired. When checked, values will 
be shown in each individual cell. When unchecked, a legend will be provided and 
each of the heat map tables will only show colored cells without values inside. 

vii. If a facility analysis is the current analysis and the segment text report is currently being 
displayed, three toggle buttons along with two drop down menus will be displayed. The two 
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drop down menus allow you to specify the specific segment within the facility and specific 
analysis period to display in the current report.  

 

1. One button will say “Switch to Formatted Report” which will allow you to display 
the segment formatted report if clicked. This will also add an ‘All Segments’ 
checkbox for you to display individual segment reports for all segments within the 
facility. 

2. The second button will say “Switch to Facility Report” which will allow you to display 
the facility text report if clicked. This will also remove the two drop down menus. 

3. The last button will say “Heat Map Report” which will allow you to display the facility 
heat map report if clicked. This will remove the two drop down menus and 
checkbox; however, it will add another drop down menu for Additional Tables 
which will allow you to add more heat map tables for different performance 
measures to the display. A ‘Show Detailed Heat Map’ checkbox will also be 
available to specify if a detailed heat map is desired. When checked, values will 
be shown in each individual cell. When unchecked, a legend will be provided and 
each of the heat map tables will only show colored cells without values inside. 

viii. If a facility analysis is the current analysis and the heat map report is currently being 
displayed, three toggle buttons along with one drop down menu will be displayed. The drop 
down menu allows you add more heat map tables for different performance measures to 
the display. 
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1. One button will say “Switch to Formatted Report” which will allow you to display 
the formatted report if clicked.  

2. The second button will say “Switch to Segment Report” or “Switch to Facility 
Report” depending on which report was displayed last before switching to the heat 
map report. Clicking “Switch to Segment Report” will allow you to display the single 
segment formatted report. Clicking “Switch to Facility Report” will allow you to 
display the facility formatted report. 

3. The last button will say “Switch to Segment Report” or “Switch to Facility Report” 
depending on what is shown for the second button. Clicking “Switch to Segment 
Report” will allow you to display the single segment formatted report. Clicking 
“Switch to Facility Report” will allow you to display the facility formatted report. 

5. The magnification of the report currently being displayed can be changed using the zoom slider found at 
the bottom right-hand corner of the screen.  

 

a. To zoom in, drag the slider to the right; to zoom out, drag the slider to the left 

b. Clicking the plus (+) button will zoom in; clicking the minus (-) button will zoom out 

c. Holding down “ctrl” on the keyboard and scrolling up on the mouse wheel will zoom in; holding “ctrl” 
on the keyboard and scrolling down on the mouse wheel will zoom out 
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Print a Report 
1. There are four options for printing a report: 

a. Selecting File > Print from the main menu; this can be found by selecting the three lines in the top 
left-hand corner of the screen and then selecting “Print”  

 

b. Selecting File > Print Preview from the main menu; this can be found by selecting the three lines in 
the top left-hand corner of the screen and then selecting “Print Preview”  

 

c. Using keyboard shortcut “Ctrl+P” for Print 

d. Using keyboard shortcut “Ctrl+F2” for Print Preview 
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2. Print 

a. Using Print will bring up a Print dialog box where you can select which printer to print to  

 

3. Print Preview 

a. Using Print Preview will bring up a window where you can view how the report will look on paper 
before sending it to the printer  

 

b. The print icon in the toolbar found in the top left-hand corner can then be selected  
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c. A print dialog box will pop up where you can select which printer to print to  
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Glossary of Terms 

50th Percentile Travel Time Index 
50th Percentile Travel Time Index (TTI50) describes the median of the TTI distribution. This can be a useful measure 
and is less influenced by outliers than the mean. 

80th Percentile Travel Time Index 
The 80th Percentile Travel Time Index (TTI80) has been found to be more sensitive to operational changes than the 
TTI95, which makes it useful for strategy comparison and prioritization purposes. In the exhibit found below, the 80th 
percentile travel time is approximately 36 minutes, thus the 80th percentile TTI is 36/15 = 2.4. 

 

95th Percentile Travel Time Index 
The 95th Percentile Travel Time Index (TTI95) is also referred to as the planning time index (PTI) and is a useful 
measure for estimating the added time travelers must budget to ensure an on-time arrival with “failure” limited to 
one trip per month. In the exhibit found below, the 95th percentile travel time is 45 min, compared to a free-flow 
travel time of 15 min; thus, TTI95 = 3.0. The planning time is the difference between the 95th percentile and free-flow 
travel times, or 30 min.  
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AADT 
The Annual Average Daily Traffic in one direction. 

Acceleration Lane Length 
This value defines the length for on-ramp acceleration lanes. The typical length of acceleration lanes for ramps 
should be obtained from the design standards used by the highway operation agency. It is measured from the 
intersection of the edge of the travel way for the freeway and the ramp (the first point) and the downstream merge 
point of the freeway and ramp edges of the travel way (the second point). The default value is 1500 feet (or 457.2 
meters in metric). 

 

The exhibit below illustrates the geometry of a typical two-lane ramp-freeway junction. It is characterized by two 
separate acceleration lanes, each successively forcing merging maneuvers to the left. 

 

For two-lane ramps, the effective acceleration length must be calculated by the user based on the lengths of the 
two lanes. In all equations using the length of the acceleration lane LA, this value is replaced by the effective length 
of both acceleration lanes LAeff. The formula for calculating effective acceleration length is: 
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LAeff = 2*LA1 + LA2 

where 

LAeff = Effective acceleration length, 

LA1 = Length of the shorter acceleration lane, and 

LA2 = Difference in length between the longer acceleration lane and the shorter acceleration lane 

In merge and diverge areas, the capacity of the two outer lanes is reduced by 100 and 200 veh/h/ln, respectively. 
When the user sets the acceleration lanes to 1500 feet (or 457.2 meters in metric), only the outer lane of the merge 
experiences a capacity reduction, as opposed to normally both of the outer two lanes. 

ACR 
The facility AADT divided by its two-way hourly capacity; this value is used in the computation of CR, which is the 
crash rate per 100 million VMT (or 161 million VkmT in metric). 

See also Highway Economic Requirements System (HERS). 

Add Analysis Period 
Clicking on the button ‘Add Analysis Period’ will add a new analysis period after the last analysis period along with 
the default values for each of the segment types. The user can add an unlimited number of analysis periods and 
can manually change the inputs to the desired values. 

Add Section 
Clicking on the button ‘Add Section’ will add rows of inputs with default Section Types of ‘Freeway Section’ and ‘On-
Ramp’ along with the corresponding default values. The user can add an unlimited number of sections and can 
manually change the inputs to the desired values. 

Add Segment 
Clicking on the button ‘Add Segment’ will add a row of inputs with the Segment Type of ‘Basic’ along with the default 
values for the Basic segment type. The user can add an unlimited number of segments and can manually change 
the inputs to the desired values. 

Adjacent Ramp 
If a ramp exists upstream or downstream of the analysis ramp and is close enough to affect the ramp-freeway 
merge or diverge operations, then an adjacent ramp exists. An adjacent ramp can be either upstream or 
downstream of the analysis ramp. The adjacent ramp must be defined as either a Merge or Diverge. 

Agency 
This field is provided to document the agency or company associated with this analysis or project. 

Analysis Direction 
The direction of the freeway being studied (e.g., Northbound) 

Analysis Period 
Freeways Analysis 

The time frame for which the traffic demand on the freeway is being studied; a single analysis period (for example, 
the peak 15 min of the peak hour) during which a capacity analysis is performed on a system element.
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Reliability Analysis 

The time interval evaluated by a single application of an HCM methodology (15 min for the freeway facility core 
methodology). In the exhibit found below, there are 12 such analysis period for the facility, represented by the rows 
in the rectangles. Each cell in a rectangle represents a single analysis period for a single analysis segment. 

 
 

 

 

 

 

 

 

Analysis Period Start Time 
This is the time specified, in HH:MM, for the beginning of the analysis period. 

Analysis Segment 
An HCM freeway segment (e.g., basic, merge, diverge, weaving) as described in Chapters 12 through 14. Each 
column in the exhibit found below represents an analysis segment. 
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Analysis Year 
This field is provided to document the year for which the analysis is being performed 

Analyst 
This field is provided to document the name of the analyst. 

Analyzed Type 
In Freeway Facilities, Analyzed Type is the Segment Type analyzed regardless of what was coded by the user. For 
example, if there is a Merge segment coded with a lane addition, the coded Merge segment will be analyzed as a 
Basic segment. 

Apply Global Inputs 
Clicking on the button 'Apply Global Inputs' will apply any input that is checked under the 'Segments Global Inputs' 
section to the entire facility. 

Area Type 
There are two area types: urban areas and rural areas. Urban areas are typified by high development densities or 
concentrations of population. Rural areas are areas with widely scattered development and low housing and 
employment densities. Generally, the entire length of the facility needs to be assigned the same area type. 

 

LOS criteria for an urban and rural freeway facility are shown in the exhibit below:  

 

Urban LOS thresholds are the same density-based criteria used for basic freeway segments. Studies on LOS 
perception by rural travelers indicate the presence of lower density thresholds when compared with their urban 
freeway counterparts. The average LOS applies to a specific analysis period, usually 15 min.  

 

LOS criteria for an urban and rural freeway facility in metric units are shown below: 

Freeway Facility Density (pc/km/ln) 

LOS    Urban      Rural 

A    ≤7      ≤4 
B    >7-11      >4-9 
C    >11-16      >9-14 
D    >16-22      >14-18 
E    >22-28      >18-24 
F    >28 or      >24 or 
  any component segment vd/c ratio > 1.00 any component segment vd/c ratio > 1.00
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Average Speed 
For Basic Freeway and Freeway Weaving Segments, Average Speed is the mean speed of the traffic stream under 
base conditions, in miles per hour. For the Basic segment procedure, the following equations are used to determine 
average speed: 

𝑆 = 𝐹𝐹𝑆௔ௗ௝                                                                                    𝑣௣ ≤ 𝐵𝑃 

𝑆 = 𝐹𝐹𝑆௔ௗ௝ −
ቀ𝐹𝐹𝑆௔ௗ௝ −

𝑐௔ௗ௝

𝐷௖
ቁ ൫𝑣௣ − 𝐵𝑃൯

௔

൫𝑐௔ௗ௝ − 𝐵𝑃൯
௔                        𝐵𝑃 < 𝑣௣ ≤ 𝑐 

where 

S = Space mean speed of the traffic stream (mi/h), 

FFSadj = Adjusted free-flow speed (mi/h), 

cadj = Adjusted segment capacity (pc/h/ln), 

Dc = Density at capacity (pc/mi/ln), 

vp = Demand flow rate under equivalent base conditions (pc/h/ln), 

BP = Breakpoint (pc/h/ln), and 

a = Exponent calibration parameter (decimal). 

 

For metric units, Average Speed is measured in kilometers per hour. 

Barrier Type 
There are two barrier types: concrete and hard barrier separation; and cone, plastic drum, or other soft barrier 
separation. 

The barrier type indicator variable, fB, can largely be interpreted as being synonymous with the distinction of short-
term versus long-term work zones, with longer-term work zones more likely to be configured using concrete barriers. 
In research, the barrier type was found to be more-clearly defined and more-readily applied than the distinction of 
short-term and long-term work zone effects. For long-term work zones, there may be a learning effect for drivers 
that increases capacities over time, but no conclusive evidence for this effect was found in the research. 

Base Free-Flow Speed 
The methodology covers basic freeway segments with a FFS in the range of 55 to 75 mi/h (or 88.5 to 120.7 km/h 
in metric). The predictive algorithm for free flow speed therefore starts with a value greater than 75 mi/h (or 120.7 
km/h in metric), specifically a default base FFS of 75.4 mi/h (121.3 km/h in metric), which resulted in the most 
accurate predictions in the underlying research. The adjusted free-flow speed is determined by subtracting each 
speed adjustment from the base free-flow speed. 

Base Dataset 
In a reliability analysis, the base dataset provides all the required input data for the freeway facilities core 
methodology described in HCM Chapter 10. Some data are specific to the freeway facility being studied. These 
include, at a minimum, all segment geometries (both general purpose and managed lanes, if applicable), free-flow 
speed, lane patterns, and segment type, along with base demands that are typically, but not necessarily, reflective 
of average (AADT) conditions. In addition, the base dataset contains the required input data to execute HCM 
Chapter 11’s reliability methodology. These data include a demand multiplier matrix, weather, work zones, and 
incident events as described later in this section. The majority of the reliability-specific input data can be defaulted 
when they are not available locally, but the analyst is encouraged to supply facility-specific data whenever feasible.
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The user has the option to load a base dataset or create a base dataset. Clicking on ‘Load Base Dataset’ will open 
a dialog box to allow the user to select a Freeways Facility (*.xuf) file for the user to open and load into the Freeways 
Reliability program. Once loaded, a facility graphic of the base dataset will be displayed on the page, along with 
general information. Clicking on ‘Create Base Dataset’ will open the HCS Freeways program to allow the user to 
create a new base dataset for use in the Freeways Reliability program. 

Base Dataset Date 
This specifies the date of the base dataset. A base scenario is always required and is used to describe base 
conditions (particularly demand and factors influencing capacity and free-flow speed). The base scenario is intended 
to represent average demand conditions (e.g., annual average daily traffic, AADT), or the demand measured on a 
specific day. HCM Chapter 11’s methods factor these demands on the basis of user-supplied or defaulted demand 
patterns to generate demands representative of all other analysis periods during the reliability reporting period. 

Base Scenario (Seed File) 
A set of parameters representing the facility’s calibrated operating conditions during one study period. All other 
scenarios are developed by adjusting the base scenario’s inputs to reflect the effects of varying demand, weather, 
incidents, work zones, or a combination of these that occur in other study periods. When the methodology is 
executed using a computational engine, the base scenario’s parameters become inputs to the seed file used by the 
engine. 

Basic Freeway Segment 
A length of freeway facility whose undersaturated operations are unaffected by weaving, diverging, or merging. 
Basic Freeway Segments are denoted as “B”. 

Capacity 
The maximum sustainable hourly flow rate at which persons or vehicles reasonably can be expected to traverse a 
point or a uniform section of a lane or roadway during a given analysis period under prevailing roadway, 
environmental, traffic, and control conditions. 

Capacity Adjustment Factor (CAF) 
Factor used to allow the user to adjust the capacity for reduced-capacity situations or to match field measurements. 
The capacity in any cell of the time-space domain can be reduced to represent incident situations such as 
construction and maintenance activities, adverse weather, traffic accidents, and vehicle breakdowns. 

CAVs 
Connected and automated vehicles, or CAVs, integrate two separate types of technology, communications and 
automation. The combination of these technologies is required to achieve roadway capacity increases, as described 
below: 

 Connected vehicles transmit data about their status to their surroundings (e.g., roadside infrastructure, 
other road users). They also receive information about their surroundings (e.g., traffic conditions, weather 
conditions, presence of potential conflicting vehicles, traffic signal timing) that motorists can use to adjust 
their driving behavior in response to conditions present at a given time and location. This exchange of 
information offers potential safety, fuel economy, and environmental benefits. However, because a human 
is still driving the vehicle, car-following and other behavior that influences freeway capacity is not expected 
to fundamentally change. 

 Automated vehicles take over all or a portion of the driving task. Depending on the level of automation, a 
human may still need to take over under certain conditions. In the absence of connectivity, the information 
available to automated vehicles is limited to that which can be gathered by on-board sensors, which is 
typically constrained by a sensor’s line of sight and the rate at which the sensor takes measurements (e.g., 
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10 time per second). As a result, for both safety and passenger comfort reasons, current adaptive cruise 
control systems offer minimum time gaps that are similar to, or longer than, the gaps used by human drivers, 
and thus may decrease roadway capacity when in widespread use. 

 Connected and automated vehicles communicate with each other and with roadside infrastructure. The 
connectivity element provides automated driving systems with more complete information about a vehicle’s 
surroundings and enables cooperative vehicle maneuvers that improve roadway operations. The vehicles’ 
enhanced detection capabilities, as well as redundancy in detection, enable an automated driving system 
to operate more efficiently and more safely than with only an on-board system. 

Coded Type 
In Freeway Facilities, Coded Type is the Segment Type coded by the user. 

Cross Weave Demand 
The exhibit below illustrates a managed lane with three general purpose (GP) freeway lanes:  

 

Where an on-ramp is in close proximity to the managed lane (ML) Access segment, the cross-weave demand is 
the on-ramp vehicles crossing all of the GP freeway lanes in the distance Lcw-min to reach the managed lane. This 
cross-weave demand can cause a reduction in the capacity of the GP lanes, which must be considered. While not 
shown, the same effect exists when an off-ramp is in close proximity to the ML Access segment, with the distance 
Lcw-min measured from the end of the access segment to off-ramp junction point. 

For a Merge segment within a facility, the cross weave demand is a portion of the Merge Demand that crosses the 
GP lanes to enter the ML. The remaining Merge Demand adds to the GP (Freeway) Demand. 

For a Diverge segment within a facility, the cross weave demand is the demand leaving the ML and entering the 
Freeway/GP lanes. The Diverge Demand is then the Demand exiting the Freeway using the off-ramp. 

For Weaving within the ML Access segment, the cross weave demand is the demand crossing between the ML and 
adjacent GP lane. 

Cross Weaving Effect 
Cross Weaving Effect applies to Merge or Diverge segments in a facility when a managed lane is present. When 
Cross Weaving Effect is checked, a ‘Cross-Weaving Effects’ section will enable with Cross Weave Demand and 
Minimum Cross Weave Length fields available.  

Where managed lanes have defined intermittent access segments, two types of weaving movements may be 
created. The exhibit below illustrates the two weaving situations that may be created.
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The exhibit illustrates a managed lane with three general purpose (GP) freeway lanes. Where an on-ramp is in 
close proximity to the managed lane (ML) Access segment, on-ramp vehicles destined for the managed lane must 
cross all of the general purpose freeway lanes in the distance Lcw-min. The cross-weave demand can cause a 
reduction in the capacity of the general purpose lanes which must be considered. While not shown, the same effect 
exists when an off-ramp is in close proximity to the ML Access segment, with the distance Lcw-min measured from 
the end of the access segment to off-ramp junction point. 

See Cross Weaving Managed Lane for the second type of cross weaving. 

Cross-Weaving Between Ramps and the ML Access Segment 

The impact of cross-weaving movements on general purpose lane capacity is handled using a CAF, as shown in 
the equation below: 

𝐶𝐴𝐹 = 1 − 𝐶𝑅𝐹 

𝐶𝑅𝐹 = −0.0897 + 0.0252 ln(𝐶𝑊) − 0.00001453𝐿௖௪ି௠௜௡ + 0.002967𝑁ீ௉ 

where 

CRF = capacity reduction factor (decimal), 

CAF = capacity adjustment factor (decimal), 

CW = cross-weave demand flow rate (pc/h), 

Lcw-min = cross-weave length (ft), and 

NGP = number of general purpose lanes (ln). 

The capacity of the general purpose lanes is then computed as: 

𝑐ீ௉஺ = 𝑐ீ௉ × 𝐶𝐴𝐹 

where 

cGPA = adjusted capacity of the general purpose lanes (veh/h), and 

cGP = unadjusted capacity of the general purpose lanes, estimated using basic freeway 
procedures in Chapter 12 (veh/h). 

 

For metric units, the cross-weave length is measured in meters; it is converted from meters to feet and then CRF is 
computed using the above equation. 

Cross Weaving Managed Lane 
Cross Weaving Managed Lane applies to a Weaving single segment. When Cross Weaving Managed Lane is 
checked, a ‘Cross Weaving’ section will enable with GP Segment Type, Minimum Cross Weaving Length, FFS of 
Managed Lane, Cross-Weave Demand, Ramp Terrain Type, Ramp Total Trucks, and Ramp Peak Hour Factor 
fields available.  

Where managed lanes have defined intermittent access segments, two types of weaving movements may be 
created. The exhibit below illustrates the two weaving situations that may be created. 
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See Cross Weaving Effect for the first type of weaving situation. 

The second type of weaving occurs within the ML Access segment, as vehicles entering and exiting from the 
managed lane cross each other within the distance Lcw-max – Lcw-min. Lcw-min is defined as distance between the on-
ramp gore area and the beginning of the manages lane access segment, while Lcw-max is the distance from the gore 
to the end of the access segment. 

Weaving Within the ML Access Segment 

Weaving within the ML Access segment is treated using the procedures of chapter 13. The access segment is 
treated as a left-side, ramp-weave segment with a length of Lcw-max – Lcw-min. 

It is assumed that the interaction and weave turbulence effect applies to the entire ML Access segment, including 
all general purpose lanes. Consequently, the methodology is identical to the evaluation of a weaving segment on 
the left side of a freeway. 

Cumulative Density Function (CDF) 
The CDF gives the number of percent of all observations at or below a specified travel time bin. The exhibit found 
below illustrates two types of distributions, with the PDF shown by the solid line and the CDF by the dashed line. 
The facility travel times shown on the x-axis represent the midpoints of the various travel bins. See also Probability 
Density Function (PDF). 

 

Current Analysis Period 
A drop-down menu is provided for Current Analysis Period to allow the user to switch between detailed input data 
for the different analysis periods coded in a dataset. 
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Current Segment 
A drop-down menu is provided for Current Segment to allow the user to switch between detailed input data for the 
different segments coded in a dataset. 

Date 
This field is provided to document the date when the analysis is performed. 

Daylight or Night 
This is used to determine whether daytime or nighttime operations are considered for work zone events. The choice 
determines the indicator variable fDN: 0 for daylight, and 1 for night. 

Deceleration Lane Length 
This value defines the length for off-ramp deceleration lanes. The typical length of deceleration lanes for ramps 
should be obtained from the design standards used by the highway operation agency. It is measured from the 
departing point between the edge of the travel way for the freeway and outer edge of the ramp (the first point) and 
the downstream intersection point of the freeway and inner ramp edge of the travel way (the second point). The 
default value is 450 feet (or 137.2 meters in metric). 

 

Two common types of diverge geometries are in use with two-lane off-ramps, as shown in the exhibit below. In the 
first, two successive deceleration lanes are introduces. In the second, a single deceleration lane is used. The left-
hand ramp lane splits from Lane 1 of the freeway at the gore area, without a deceleration lane. 

 

Where a single deceleration lane is used, there is no modification to the length of the deceleration lane LD; where 
two deceleration lanes exist, the length is replaced by the effective length LDeff in all equations. 



____________________________________________________________________________________________________ 
 Freeways User Guide     Glossary of Terms · 79 

For two-lane ramps in the Freeways module, the effective deceleration length must be calculated by the user based 
on the lengths of the two lanes. Where two deceleration lanes exist, the length of the deceleration lane LD is replaced 
by the effective length LDeff in all equations. The formula for calculating effective deceleration length is: 

LDeff = 2*LD1 + LD2 

where 

LDeff = Effective deceleration length, 

LD1 = Length of the shorter deceleration lane, and 

LD2 = Difference in length between the longer deceleration lane and the shorter deceleration lane 

In merge and diverge areas, the capacity of the two outer lanes is reduced by 100 and 200 veh/h/ln, respectively. 
When the user sets the deceleration lanes to 1500 feet (or 457.2 meters in metric), only the outer lane of the diverge 
experiences a capacity reduction, as opposed to normally both of the outer two lanes. 

Delete Analysis Period 
Clicking on the button ‘Delete Analysis Period’ will delete the analysis period currently selected. 

Delete Section 
After the user selects a section(s) to delete, clicking on the button ‘Delete Section’ will delete the row(s) of inputs 
from all analysis periods corresponding to the selected section(s). 

Delete Segment 
After the user selects a segment(s) to delete, clicking on the button ‘Delete Segment’ will delete the row(s) of inputs 
from all analysis periods corresponding to the selected segment(s). 

Demand 
The number of vehicles or other roadway users desiring to use a given system element during a specific analysis 
period, typically 1 h or 15 min. 

Demand flow rates must be specified for the entering freeway mainline flow and for each merge and diverge 
segment. For Merge and Diverge analyses, the demand for adjacent ramps must also be specified if one exists 

For weaving segments, demand flow rates must be identified by component movement: freeway to freeway, ramp 
to freeway, freeway to ramp, and ramp to ramp. Where this level of detail is not available, the following procedure 
may be used to estimate the component flows. It is not recommended, however, as weaving segment performance 
is sensitive to the split of demand flows. 

 Ramp-weave segments: Assume that the ramp-to-ramp flow is 0. The ramp-to-freeway flow is then equal 
to the on-ramp flow; the freeway-to-ramp flow is then equal to the off-ramp flow. 

 Major weave segments: On-ramp flow is apportioned to the two exit legs (freeway and ramp) in the same 
proportion as the total flow on the exit legs (freeway and ramp). 

Demand Adjustment Factor (DAF) 
Factor used to allow the user to adjust the demand for the purpose of calibration, or to reflect the impacts of weather, 
incidents, and work zones. 

Demand Ratios 
The exhibits found below present default demand ratios by day of week and month of year for urban and rural 
freeway facilities. The ratios were derived from a national freeway dataset developed by SHRP 2 Project L03. All 
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ratios reflect demand relative to a Monday in January. Where possible, analysts should obtain local or regional 
estimates of demand variability to account for facility-specific and seasonal trends on the subject facility. 

Default Urban Freeway Demand Ratios (ADT/Mondays in January): 

 

Default Rural Freeway Demand Ratios (ADT/Mondays in January): 

 

These default demand ratios are displayed in the first table of the Demand page depending on the Freeway Area 
Type selected. The second table of the Demand page displays the demand ratios relative to the base dataset. The 
values in the first table can be edited by the user, if necessary, and the corresponding values in the second table 
will change based on the edited values. 

Density 
The number of vehicles occupying a given length of a lane or roadway at a particular instant. It is expressed as 
passenger cars per mile per lane (pc/mi/ln) or vehicles per mile per lane (veh/mi/ln). It is the performance measure 
that determines Level of Service. Density is computed as flow rate (pc/h/ln) divided by speed (mi/h). 
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For metric units, it is expressed as passenger cars per kilometer per lane (pc/km/ln) or vehicles per kilometer per 
lane (veh/km/ln) and is computed as flow rate (pc/h/ln) divided by speed (km/h). 

Density at Capacity 
The value of density when the component segments or facility is considered at capacity. The density at capacity is 
45 pc/mi/ln (or 28 pc/km/ln in metric), which must be converted to veh/mi/ln (or veh/km/ln in metric) by using the 
heavy-vehicle adjustment factor fhv described in Chapter 12, Basic Freeway and Multilane Highway Segments. 

Thus, when a facility-level analysis is performed, LOS F for a component segment will be identified in two 
complementary ways: 

 When vd/c is greater than 1.00 for one or more critical segments, or 

 When the segment density is greater than 45 pc/mi/ln (or 28 pc/km/ln in metric) for basic freeway segments 
or 43 pc/mi/ln (or 27 pc/km/ln in metric) for weaving segments. 

Design Analysis 
Select the ‘Design Analysis’ checkbox to add a table to the report listing the results for the current freeway segment 
with different number of lanes. This can help guide the design of freeways with certain design standards. 

D-factor 
D is the proportion of traffic moving in the peak direction of travel on a given roadway during the peak hour. It is 
used, along with AADT (annual average daily traffic) and the K-factor (proportion of AADT occurring during the peak 
hour), in the following equation to determine the demand volume (V) or directional peak-hour demand volume 
(DDHV) in a planning and preliminary engineering analysis: 

V = DDHV = AADT × K × D 

Directional distributions vary, but a typical value for both urban and rural freeways is 0.55. As with all default values, 
locally or regionally calibrated values are preferred and yield more accurate results. Both the K-factor and the D-
factor have a significant impact on the estimated hourly demand volume. 

Distance to Adjacent Ramp 
The distance from the analysis ramp to the adjacent ramp 

Diverge Segment 
A freeway segment in which a single traffic stream divides to form two or more separate traffic streams. Also freeway 
diverge segment. Off-ramps refer to freeway diverge segments. An off-ramp is a ramp that accommodates diverging 
maneuvers. Off-ramps are denoted as “OFR”. 

Driver Population 
Driver population describes the level of driver familiarity in the traffic stream and is used in adjustments for speed 
and capacity. The base traffic stream characteristics for basic freeway segments are representative of traffic 
streams composed primarily of commuters or drivers who are familiar with the facility. 

The driver population adjustment factor fp had previously been used in the HCM to reflect the effects of unfamiliar 
drivers in the traffic stream and was applied as an increase in demand volume. With the addition of a unified speed 
flow equation in Chapter 12 of the HCM and the ability to adjust both the base FFS and capacity in all freeway 
segment chapters (12-14) to account for incidents and weather events, the driver population factor is no longer 
used. Instead, FFS and capacity adjustment factors SAFpop and CAFpop are applied in combination with other 
applicable SAFs and CAFs. 
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Analyst judgment is still required when applying recommended adjustments. However, should there be expectations 
of significant presence of unfamiliar drivers, the values shown in the exhibit below can serve as a guide for the 
analysis. 

 

Equilibrium Separation Distance 
Where an upstream or downstream adjacent off-ramp exists on a six-lane freeway, a determination as to whether 
the ramp is close enough to the subject merge area to influence the area’s operation is necessary. The 
determination is made by finding the equilibrium separation distance LEQ. If the actual distance is larger than or 
equal to LEQ, then Equation 14-3 should be used. If the actual distance is shorter than LEQ, then Equation 14-4 or 
Equation 14-5 should be used as appropriate. The equilibrium distance is obtained by finding the distance at which 
Equation 14-3 would yield the same value of PFM as Equation 14-4 or Equation 14-5 as appropriate. This results in 
the following: 

For adjacent upstream off-ramps, use Equation 14-6: 

𝐿ாொ = 0.214(𝑣ி + 𝑣ோ) + 0.444𝐿஺ + 52.32𝑆ிோ − 2403 

For adjacent downstream off-ramps, used Equation 14-7: 

𝐿ாொ =
𝑣஽

0.1096 + 0.000107𝐿஺

 

Where an upstream on-ramp or downstream off-ramp on a six-lane freeway exists, a determination as to whether 
the ramp is close enough to the subject off-ramp to affect its operation is necessary. As was the case for on-ramps, 
this is done by finding the equilibrium distance LEQ. This distance is determined when Equation 14-9 yields the same 
value of PFD as Equation 14-10 (for adjacent upstream on-ramps) or Equation 14-11 (adjacent downstream off-
ramps). When the actual distance between the ramps is greater than or equal to LEQ, Equation 14-9 is used. When 
the actual distance between ramps is less than LEQ, Equation 14-10 or Equation 14-11 is used as appropriate. 

For adjacent upstream on-ramps, use Equation 14-12: 

𝐿ாொ =
𝑣௎

0.071 + 0.000023𝑣ி − 0.000076𝑣ோ

 

For adjacent downstream off-ramps, use Equation 14-13: 

𝐿ாொ =
𝑣஽

1.15 + 0.000032𝑣ி − 0.000369𝑣ோ

 

Export Buttons 
Export buttons are provided on the Events page and Summary page in a reliability analysis.  

On the Events page, Export to CSV is provided under each tab for the user to export the table results into a CSV 
file. For example, if the user wants to export the Incident data, a dialog box will appear after clicking ‘Export to CSV’ 
under the Incident tab. The user can specify a name for the CSV file or keep the default name. After saving the file, 
all incident events from all pages will be saved in CSV format. 

On the Summary page, three export buttons are provided. These include: Export Summary Results to CSV, Export 
to XUF, and Export Facility to CSV. ‘Export Summary Results to CSV’ is similar to the export buttons on the Events 
page. Clicking this button will allow the user to save the summary results displayed in the table to be saved in CSV 
format. ‘Export to XUF’ will allow the user to save all the scenarios generated in the Freeways XUF format. Clicking 
this button will open a dialog box allowing the user to browse folders or create a folder which will save a folder with 
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all the scenarios generated. The folder holding all the scenarios will be titled the same as the Freeways Reliability 
XFR file and all the scenarios will be titled Scenario#, with # being the corresponding scenario number. ‘Export 
Facility to CSV’ will export the inputs of each scenario into corresponding CSV files. 

Facility Evaluation 
In the facility evaluation step in a reliability analysis, each scenario is analyzed using the freeway facilities core 
methodology. The performance measures of interest to the evaluation—in particular, facility travel time—are 
calculated for each analysis period in each scenario and stored. At the end of this process, a travel time distribution 
is formed from the travel time results stored for each scenario. 

Failure or On-Time Measures 
The percentage of analysis time periods with space mean speeds above (on time) or below (failure) one or more 
target values (e.g., 35, 45, and 50 mi/h; or 56, 72, and 80 km/h in metric). These measures address how often trips 
succeed or fail in achieving a desired travel time or speed. 

Flow Rate 
The equivalent hourly rate at which vehicles or other roadway users pass over a given point or section of a lane or 
roadway during a given time interval of less than 1 h, usually 15 min 

Free-Flow Speed 
1. The average speed of vehicles on a given segment, measured under low-volume conditions, when drivers 

are free to drive at their desired speed and are not constrained by the presence of other vehicles or 
downstream traffic control devices. 

2. The theoretical speed when both density and flow rate are zero. 

The adjusted free-flow speed is determined by the HCM equation found below.  

FFS = BFFS – fLW – fRLC – 3.22 × TRD0.84 

where 

FFS = free-flow speed of the basic freeway segment (mi/h), 

BFFS = base FFS for the basic freeway segment (mi/h), 

fLW = adjustment for lane width (mi/h), 

fRLC = adjustment for right-side lateral clearance (mi/h), and 

TRD = total ramp density (ramps/mi). 

If a field measured free-flow speed is entered, no subsequent adjustments are made and the adjusted free-flow 
speed will simply be the field-measured free-flow speed. Freeway Merge, Diverge, and Weaving segments require 
direct speed measurements, estimated from design speed or speed limit. 

For metric units, Free-Flow Speed, along with all the corresponding adjustments, are measured in kilometers per 
hour. 

Freeway Facility 
An extended length of freeway composed of continuously connected basic freeway, weaving, merge, and diverge 
segments. 
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GP Segment Type 
The General Purpose (GP) Segment Type establishes if there is an Upstream On-Ramp or a Downstream Off-
Ramp that interacts with the ML Access Segment. 

Grade Length 
The length of the segment, in miles (or kilometers in metric), to represent the percent grade 

Growth Factor 
The traffic growth factor is provided to dynamically scale the traffic volume to represent future conditions. Values 
less than 1 will reduce the demand and values more than 1 will increase the demand. 

Heavy Vehicle Adjustment Factor 
fHV denotes the adjustment factor for presence of heavy vehicles in the traffic stream. All heavy vehicles are 
classified as single-unit trucks (SUTs) or tractor-trailers (TTs). 

The heavy-vehicle adjustment factor is computed as follows: 

𝑓ு௏ =
1

1 + 𝑃்(𝐸் − 1)
 

where 

fHV = heavy-vehicle adjustment factor (decimal), 

PT = proportion of SUT and TTs in traffic stream (decimal), and 

ET = passenger-car equivalent of one heavy-vehicle in the traffic stream (PCEs). 

Highway Economic Requirements System (HERS) 
When the crash rate is not available locally, the Highway Economic Requirements System (HERS) model can be 
used to estimate it. The crash or incident rate is estimated per 100 million VMT (or per 161 million VkmT in metric). 
The HERS models uses the following equation to estimate crash rate: 

𝐶𝑅 = (154.0 − 1.203 × 𝐴𝐶𝑅 + 0.258 × 𝐴𝐶𝑅ଶ − 0.00000524 × 𝐴𝐶𝑅ହ) × 𝑒଴.଴଴଼ଶ×(ଵଶି௅ௐ) 

where CR is the crash rate per 100 million VMT (or per 161 million VkmT in metric), ACR is the facility AADT divided 
by its two-way hourly capacity, and LW is the lane width in feet (or meters in metric). 

Import from XUF File 
Clicking this will allow the user to choose a file to override the default event creation. 

Incident Distribution and Duration 
The duration of each incident severity type is assumed to follow a lognormal distribution. The default parameters 
for the incident duration distribution was developed through research. The defaults for freeway incident severity 
distribution and duration parameters, in minutes, are provided below: 
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Incident Frequency Data 
Radio button choices are provided for specifying the type of Incident Frequency Data. These choices include: Local 
Incident Frequency, Local Crash Frequency, and Calculated Crash Frequency.  

Selecting Local Incident Frequency will provide a table with defaults for Incident Frequency (per 100 million VMT in 
USC or per 161 million VkmT in metric) that vary by month. The values are editable for the user to calibrate for local 
conditions.  

Selecting Local Crash Frequency will provide a table with defaults for Crash Frequency (per 100 million VMT in 
USC or per 161 million VkmT in metric) that vary by month. The values are editable for the user to calibrate for local 
conditions. In addition to this table, a field is provided for the user to specify the Incident-to-Crash Ratio (ICR). 

Selecting Calculated Crash Frequency will cause the Highway Economic Requirements System (HERS) model to 
be used to calculate crash rate. Fields for ICR, ACR, and Lane Width will also be provided for the user to specify. 

Incident Type 
The following exhibit shows the default CAFs associated with each incident severity: 

 

The values shown in the exhibit reflect the remaining relative capacity per open lane. For example, a two-lane 
closure incident on a six-lane directional facility (underscored) results in a loss of two full-lane capacities, in 
addition to maintaining only 75% of the remaining four open lanes’ capacities. The result is that only three lanes 
worth (50%) of the facility’s original six-lane capacity is maintained. No information is currently available on the 
effect of incidents on free-flow speed, so this effect is not accounted for at this time. 

Incident-to-Crash Ratio (ICR) 
ICR is the local incident-to-crash ratio. In the absence of other data, a national default value for ICR is 4.9. 
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Insert Analysis Period 
Clicking on the button ‘Insert Analysis Period’ will add a new analysis period in the position of the selected analysis 
period. For example, if analysis period 3 is currently selected, inserting an analysis period will create a new analysis 
period 3. The previous analysis period 3 will become analysis period 4 and so on. The user can insert an unlimited 
number of analysis periods. 

Insert Section 
Clicking on the button ‘Insert Section’ will add a row of inputs with the Section Type of ‘Freeway Section’ along with 
the default values for the Freeway Section type above the selected section. The user can insert an unlimited number 
of sections and can manually change the inputs to the desired values. 

Insert Segment 
Clicking on the button ‘Insert Segment’ will add a row of inputs with the Segment Type of ‘Basic’ along with the 
default values for the Basic segment type above the selected segment. The user can insert an unlimited number of 
segments and can manually change the inputs to the desired values. 

Interchange Density 
The average number of interchanges per mile, measured over 3 miles upstream and 3 miles downstream from the 
midpoint of the weaving segment. 

For metric units, it is the average number of interchanges per kilometer, measured over 4.8 kilometers upstream 
and 4.8 kilometers downstream from the midpoint of the weaving segment. 

Items per page 
A drop down menu is provided for the user to specify the scenarios or events to be displayed per page. 

Jam Density 
The maximum density that can be achieved on a segment. It occurs when speed is zero (i.e., when there is no 
movement of persons or vehicles). 

Jurisdiction 
This field is provided to document any jurisdiction convention or project related information. 

K-factor 
K is the proportion of AADT (annual average daily traffic) that occurs during the peak hour. It is used, along with 
AADT and the D-factor (the proportion of peak-hour volume traveling in the peak direction), in the following equation 
to determine the demand volume (V) or directional peak-hour demand volume (DDHV) in a planning and preliminary 
engineering analysis: 

V = DDHV = AADT × K × D 

On urban freeways, the typical range of K-factors is from 0.08 to 0.10. On rural freeways, values typically range 
between 0.09 and 0.13. As with all default values, locally or regionally calibrated values are preferred and yield 
more accurate results. Both the K-factor and the D-factor have a significant impact on the estimated hourly demand 
volume. 
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Lane Addition 
A location along a roadway where the number of continuous through lanes increases by one or more. 

On-ramps do not always include merge elements. In some cases, there are lane additions at on-ramps. Lane 
additions are defined as merge segments with acceleration lane lengths exceeding 1,500 ft (or 457.2 m in metric).  

Analysis of single-lane additions is relatively straightforward. The freeway segment downstream of the on-ramp is 
simply considered to be a basic freeway segment with an additional lane. The procedures in Chapter 12, Basic 
Freeway and Multilane Highway Segments, should be applied in this case. 

See also Lane Drop. 

Lane Closure Type 
Lane Closure Type expresses how many lanes are closed in the work zone. 

The lane closure configuration in a work zone is expressed as the ratio of the number of original lanes to the number 
of lanes present in the work zone. For instance, a 3-to-1 lane closure configuration means that three lanes are 
normally available, but that two lanes were closed during construction and only one lane was open. Research shows 
that this ratio is effective in showing the influences of different lane configurations on speed or capacity. 

Lane Drop 
A location along a roadway where the number of through lanes is reduced by one or more. 

Off-ramps do not always include diverge elements. In some cases, there are lane drops at off-ramps. Lane drops 
are defined as diverge segments with deceleration lane lengths exceeding 1,500 ft (or 457.2 m in metric). 

Analysis of single-lane drops is relatively straightforward. The freeway segment upstream of the off-ramp is simply 
considered to be a basic freeway segment with an additional lane. The procedures in Chapter 12, Basic Freeway 
and Multilane Highway Segments, should be applied in this case. 

See also Lane Addition. 

Lane Width 
The lateral distance between stripes for a given lane; measured in feet (or meters in metric) 

Lane Width Adjustment 
This is an adjustment to Base Free-Flow Speed based on the average lane width. The base condition for lane width 
is 12 ft or greater. When the average lane width across all lanes is less than 12 ft, the FFS is negatively affected. 
Adjustments to reflect the effect of narrower average lane width are shown below: 

 

For metric units, Average Lane Width is measured in meters, and the corresponding Lane Width Adjustment is 
measured in kilometers per hour. 

Lane-by-Lane Analysis 
A facility analysis must be open to apply a lane-by-lane analysis. A ‘Lane-by-Lane Analysis’ checkbox is provided 
under the Facility Global Inputs section on the General page. Checking it will apply the lane-by-lane analysis 
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methodology from HCM chapter 38 to the file. When it is applied, new sections on the Details page will become 
available. 

Lateral Clearance Adjustment 
This is an adjustment to Base Free-Flow Speed based on the Right-Side Lateral Clearance. The base condition for 
right-side lateral clearance is 6 ft (or 1.8 m in metric) or greater. The lateral clearance is measured from the right 
edge of the travel lane to the nearest lateral obstruction. Care must be taken to identify a “lateral obstruction.” Some 
obstructions may be continuous, such as retaining walls, concrete barriers, guardrails, or barrier curbs. Others may 
be periodic, such as light supports or bridge abutments. In some cases, drivers may be accustomed to certain types 
of obstructions, often making their influence on traffic negligible.  

Adjustments to the base FFS due to the existence of obstructions closer than 6 ft to the right travel lane edge are 
shown below: 

 

Median clearances of 2 ft (or 0.6 m in metric) or more generally have little impact on traffic. No adjustments are 
available to reflect the presence of left-side lateral obstructions closer than 2 ft (or 0.6 m in metric) to the left travel 
lane edge. Such situations are, however, quite rare on modern freeways, except in constrained work zones. 

The impact of a right-side lateral clearance restriction depends on both the distance to the obstruction and the 
number of lanes in one direction on the basic freeway segment. A lateral clearance restriction causes vehicles in 
the right lane to move somewhat to the left. This movement, in turn, affects vehicles in the next lane. As the number 
of lanes increases, the overall effect on freeway operations decreases. 

Lateral Distance 
The distance, in feet (or meters in metric), from the edge of travel lane adjacent to the work zone to the barrier, 
barricades, or cones. 

Level of Service (LOS) 
A quantitative stratification of a performance measure or measures that represent quality of service, measured on 
an A-F scale, with LOS A representing the best operating conditions from the traveler’s perspective and LOS F the 
worst. 

 

Units: USC 

LOS criteria for urban and rural freeway facilities are shown below. Urban LOS thresholds are the same density-
based criteria used for basic freeway segments. Studies on LOS perception by rural travelers indicate the presence 
of lower density thresholds when compared with their urban freeway counterparts. The average LOS applies to a 
specific analysis period, usually 15 min. 



____________________________________________________________________________________________________ 
 Freeways User Guide    Glossary of Terms · 89 

 

User of a LOS descriptor for the overall freeway facility must be done with care. It is critical that the LOS for individual 
segments composing the facility also be reported. Because the overall LOS is an average, it may mask serious 
problems in individual segments of the facility. 

For urban freeway facilities, LOS A through E are defined using the same densities that apply to basic freeway 
segments. Rural freeway facilities have lower density thresholds. This difference is a results of rural motorists’ 
higher LOS expectations. The analyst is cautioned that a rural facility analysis may produce LOS F without any of 
its segment experiencing breakdown (vd/c > 1). As a result, LOS F for a facility represents a case in which any 
component segment of the freeway has a vd/c ratio that exceeds 1.00, or the average density of the study facility 
exceeds 45 pc/mi/ln (for urban freeways) or 39 pc/mi/ln (for rural freeways).  

The following provides LOS criteria for basic freeway segments: 

 

The following provides LOS criteria for weaving segments on freeways, collector-distributor (C-D) roads, and 
multilane highways: 

 

The following provides LOS criteria for freeway merge and diverge segments. These criteria apply to all ramp-
freeway junctions and may also be applied to major merge and diverges; high-speed, uncontrolled merge or diverge 
ramps on multilane highway sections; and merge and diverges on freeway C-D roadways. LOS is not defined for 
ramp roadways, while the LOS of a ramp-street junction is defined in Chapter 23, Ramp Terminals and Alternative 
Intersections. 
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Units: Metric 

Density is measured in passenger cars per kilometer per lane. LOS criteria for urban and rural freeway facilities are 
shown below. Urban LOS thresholds are the same density-based criteria used for basic freeway segments. Studies 
on LOS perception by rural travelers indicate the presence of lower density thresholds when compared with their 
urban freeway counterparts. The average LOS applies to a specific analysis period, usually 15 min. 

     Density (pc/km/ln) 

LOS   Urban      Rural 

A   ≤7      ≤4 
B   >7-11      >4-9 
C   >11-16      >9-14 
D   >16-22      >14-18 
E   >22-28      >18-24 
F   >28 or      >24 or 
 any component segment vd/c ratio > 1.00 any component segment vd/c ratio > 1.00 

User of a LOS descriptor for the overall freeway facility must be done with care. It is critical that the LOS for individual 
segments composing the facility also be reported. Because the overall LOS is an average, it may mask serious 
problems in individual segments of the facility. 

For urban freeway facilities, LOS A through E are defined using the same densities that apply to basic freeway 
segments. Rural freeway facilities have lower density thresholds. This difference is a results of rural motorists’ 
higher LOS expectations. The analyst is cautioned that a rural facility analysis may produce LOS F without any of 
its segment experiencing breakdown (vd/c > 1). As a result, LOS F for a facility represents a case in which any 
component segment of the freeway has a vd/c ratio that exceeds 1.00, or the average density of the study facility 
exceeds 28 pc/km/ln (for urban freeways) or 24 pc/km/ln (for rural freeways).  

The following provides LOS criteria for basic freeway segments: 

LOS  Density (pc/km/ln) 

A  ≤7 
B  >7-11 
C  >11-16 
D  >16-22 
E  >22-28 
F  Demand exceeds capacity OR density > 28 

The following provides LOS criteria for weaving segments on freeways, collector-distributor (C-D) roads, and 
multilane highways: 

     Density (pc/km/ln) 

           Weaving Segments on Multilane 
LOS      Freeway Weaving Segments   Highway or C-D Roads 

A   0-6      0-7 
B   >6-12      >7-15 
C   >12-17      >15-20 
D   >17-22      >20-22 
E   >22-27      >22-25 
F >27, or demand exceeds capacity    >25, or demand exceeds capacity 

The following provides LOS criteria for freeway merge and diverge segments. These criteria apply to all ramp-
freeway junctions and may also be applied to major merge and diverges; high-speed, uncontrolled merge or diverge 
ramps on multilane highway sections; and merge and diverges on freeway C-D roadways. LOS is not defined for 
ramp roadways, while the LOS of a ramp-street junction is defined in Chapter 23, Ramp Terminals and Alternative 
Intersections. 
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LOS  Density (pc/km/ln) 

A  ≤6 
B  >6-12 
C  >12-17 
D  >17-22 
E  >22 
F  Demand exceeds capacity 

Level Terrain 
Any combination of grades and horizontal or vertical alignment that permits heavy vehicles to maintain the same 
speed as passenger cars, typically containing short grades of no more than 2%. 

Level of Travel Time Reliability (LOTTR) 
Level of travel time reliability, or LOTTR, is the measure of the 80th percentile travel time index (TTI80) divided by 
the 50th percentile travel time index (TTI50): 

LOTTR = TTI80 / TTI50 

Local Crash Frequency 
Fields are provided for Crash Frequency (per 100 million VMT in USC or per 161 million VkmT in metric) if the 
analyst is aware of recurring crash occurrences that vary by month. If, for example, crashes are more likely in winter 
months (despite potentially lower demands), the analyst should adjust the crash rate defaults and calibrate for local 
conditions. 

Local Incident Frequency 
Fields are provided for Incident Frequency (per 100 million VMT in USC or per 161 million VkmT in metric) if the 
analyst is aware of recurring incident occurrences that vary by month. If, for example, incidents are more likely in 
winter months (despite potentially lower demands), the analyst should adjust the incident rate defaults and calibrate 
for local conditions. 

Location 
Rainfall, snow, temperature, and visibility weather data were collected for several different cities. Defaults are 
provided by month for each of the cities listed in the drop down menu on the Weather page. If a city is not listed 
and the analyst has local data available, the fields in the table can be edited and the Current Location will become 
‘Custom’. 

Major Diverge 
In a single segment diverge analysis, a Major Diverge checkbox will appear when the number of Ramp Lanes is 2. 
The checkbox will be hidden when the number of Ramp Lanes is 1. When Major Diverge is checked, the text and 
formatted report results will change to reflect a major diverge analysis. 

A major diverge area is one in which two primary roadways, each having multiple lanes, diverge from a single 
freeway segment. Such junctions occur when a freeway splits to become two separate freeways or when a major 
multilane high-speed ramp diverges from the freeway. Major diverges are different from one- and two-lane off-
ramps in that each of the diverging roadways is generally at or near freeway design standards and no clear ramp 
or deceleration lane is involved in the diverge. 

The two common geometries for major diverge areas are illustrated in the exhibit below. In the first case, the number 
of lanes leaving the diverge area is the same as the number entering it. In the second, the number of lanes leaving 
the diverge are is one more than the number entering it.
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The principal analysis of a major diverge area involves checking the capacity of entering and departing roadways, 
all of which are generally built to mainline standards. A failure results when any of the demand flow rates exceeds 
the capacity of the segment. 

For major diverge areas, a model exists for computing the average density across all approaching freeway lanes 
within 1,500 ft of the diverge, as given in the following equation: 

𝐷ெ஽ = 0.0175 ቀ
𝑣ி

𝑁
ቁ 

where 

DMD = density in the major diverge influence area (which includes all approaching freeway lanes 
(pc/mi/ln) 

vF = demand flow rate immediately upstream of the major diverge influence area (pc/h), and 

N = number of lanes approaching the major diverge (ln). 

The result can be compared with the criteria of HCM Exhibit 14-3 to determine a LOS for the major diverge influence 
area. Note that the density and LOS estimates are only valid for stable cases (i.e., not in cases in which LOS F 
exists because of a capacity deficiency on the approaching or departing legs of the diverge). 

For metric units, the calculated density in pc/mi/ln is converted to pc/km/ln. 

Managed Lane 
A limited number of lanes set aside within a freeway cross section where multiple operational strategies are utilized 
and actively adjusted as needed for the purpose of achieving predefined performance objectives. Examples include 
priced lanes and special-use lanes such as high-occupancy vehicle (HOV), high-occupancy toll (HOT), express, 
bus-only, or truck-only lanes.  

The vehicle composition, driver type, free-flow speed, capacity, and driver behavior characteristics of managed lane 
traffic streams are quite different from those of general purpose lanes. In addition, interaction occurs between the 
two traffic streams, especially when there is no physical barrier separation between the managed and general 
purpose lanes. 

Managed Lane Segment Type 
Four types of managed lane (ML) freeway segments are defined in HCM Chapters 12 through 14: ML merge and 
diverge segments, ML weaving segments, ML access segments, and ML basic freeway segments.  

The analysis procedures for general purpose lanes with adjacent managed lanes build on the core methodology’s 
segment classification. In addition, the lane group concept is introduced to allow analysts to assign separate 
attributes to managed and general purpose lanes, while retaining a degree of interaction between the two facilities. 
The adjacent lane groups (one general purpose and one managed) are required to have the same segment length. 

HCS Freeways allows selection of five different types of managed lanes: ML Basic, ML Merge, ML Diverge, ML 
Weave, and ML Access. 
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Managed Lane Separation Type 
Five types of basic managed lane segments are identified, based on the number of managed lanes and the type of 
separation from the general purpose lanes. The speed-flow characteristics of each basic managed lane segment 
type are different. The five segment types include: 

1. Continuous Access. Skip-stripe or solid single line-separated, single lane. 

2. Buffer 1. Buffer-separated, single lane. 

3. Buffer 2. Buffer-separated, multiple lanes. 

4. Barrier 1. Barrier-separated, single lane. 

5. Barrier 2. Barrier-separated, multiple lanes. 

Maximum Weaving Length 
Strictly defined, maximum length is the length at which weaving turbulence no longer has an impact on operations 
within the segment, or alternatively, on the capacity of the weaving segment. This methodology uses the second 
definition (based on the equivalence of capacity). The maximum length of a weaving segment (in feet) is computed 
from Equation 12-4: 

𝐿ெ஺௑ = [5,728(1 + 𝑉𝑅)ଵ.଺] − [1,566𝑁ௐ௅] 

where 

LMAX = maximum weaving segment length (using the short length definition) 

VR = volume ratio 

NWL = number of lanes from which weaving maneuvers may be made with either one or no lane 
changes 

The value of LMAX is used to determine whether continued analysis of the configuration as a weaving segment is 
justified: 

 If LS < LMAX, continue to Step 5 (Determine Weaving Segment Capacity); or 

 If LS ≥ LMAX, analyze the merge and diverge junctions as separate segments by using the methodology in 
Chapter 13. 

 

For metric units, the maximum weaving length is measured in meters; it is computed using the above equation and 
then converted from feet to meters. 

Mean Travel Time Index (TTImean) 
TTImean describes the mean of the TTI distribution. This can be a useful measure and more influenced by outliers 
than the median. 

Measured Free-Flow Speed 
The measured free-flow speed is the FFS measured in the field and provided by the user. If the FFS is measured 
directly, no adjustments are applied to the measured value. 

Merge Segment 
A freeway segment in which two or more traffic streams combine to form a single traffic stream. Also freeway merge 
segment. On-ramps refer to freeway merge segments. An on-ramp is a ramp that accommodates merging 
maneuvers. On-ramps are denoted as “ONR”. 



____________________________________________________________________________________________________ 
 94 · Glossary of Terms   Freeways User Guide 

Minimum Cross Weaving Length 
Lcw-min is the minimum cross weaving length. Where an on-ramp is present, Lcw-min is defined as the distance between 
the on-ramp gore area and the beginning of the managed lane access segment. Where an off-ramp is present, Lcw-

min is the distance measured from the end of the access segment to off-ramp junction point. 

For weaving within the ML Access segment, vehicles entering and exiting from the managed lane cross each other 
within the distance Lcw-max – Lcw-min. Lcw-min is defined as distance between the on-ramp gore area and the beginning 
of the managed lane access segment, while Lcw-max is the distance from the gore to the end of the access segment. 

These distances are illustrated in the exhibit below: 

 

Minimum Freeway-to-Ramp Lane Changes 
Minimum number of lane changes that a freeway-to-ramp weaving vehicle must make to complete the freeway-to-
ramp movement successfully. This is only applicable for one-sided weaving segments. This is denoted as LCFR. 

Minimum Lane Change Rate 
The minimum rate of lane changing that must exist for all weaving vehicles to complete their weaving maneuvers 
successfully, in lane changes per hour (lc/h). 

𝐿𝐶ெூே = (𝐿𝐶ோி × 𝑣ோி) + (𝐿𝐶ிோ × 𝑣ிோ) 

where 

LCMIN = minimum rate of lane changing that must exist for all weaving vehicles to complete their 
weaving maneuvers successfully (lc/h) 

LCRF = minimum number of lane changes that must be made by a single weaving vehicle moving 
from the on-ramp to the freeway (lc/h) 

vRF = ramp-to-freeway demand flow rate in the weaving segment (pc/h) 

LCFR = minimum number of lane changes that must be made by a single weaving vehicle moving 
from the freeway to the off-ramp (lc/h) 

vFR = freeway-to-ramp demand flow rate in the weaving segment (pc/h) 

Minimum Ramp-to-Freeway Lane Changes 
Minimum number of lane changes that a ramp-to-freeway weaving vehicle must make to complete the ramp-to-
freeway movement successfully. This is only applicable for one-sided weaving segments. This is denoted as LCRF. 

Minimum Ramp-to-Ramp Lane Changes 
Minimum number of lane changes the must be made by one ramp-to-ramp vehicle to execute the desired maneuver 
successfully. This is only applicable for two-sided weaving segments. This is denoted as LCRR. 
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Misery Index 
A measure comparing the average of the worst 5% of travel times to the free-flow travel time. 

Mixed-Flow Model 
The mixed-flow model is one of two distinct methodologies offered to assess the effect of heavy vehicles on capacity 
and LOS on freeways in the HCM. The model directly assesses the capacity, speed, and density of traffic streams 
that include a significant percentage of heavy vehicles operating on a single or composite grade. When using the 
mixed-flow models, no PCEs are needed, as the passenger car, SUT, and TT volumes are used directly in the 
estimation of mixed-flow speed and density. 

For most freeway analyses, PCE tables are sufficient and provide a reasonable approximation of the truck effects. 
However, if truck percentages are high, grades are significant, or both, the mixed-flow model is expected to give a 
more accurate result. If estimates of the actual mixed-flow speeds and densities are desired, the mixed-flow model 
in Volume 4 of the HCM should be employed. If the basic freeway segment is analyzed as part of a freeway facility 
using the methodology in Chapter 10 of the HCM, a PCE approximation is typically appropriate and recommended. 

For a Basic single segment, a Mixed Flow Model checkbox is provided. This checkbox is enabled only when the 
Terrain Type is coded as Specific Grade. 

For a freeway facility, a Mixed Flow Model checkbox is provided on the General page. This checkbox is enabled 
only when the facility has Basic segments coded. If any other segment type is added to the facility, the checkbox 
will be disabled and the mixed flow model will not be applied. If ‘Mixed Flow Model’ is checked, the mixed-flow 
model for composite grades will be applied. The procedure builds on the single-grade methodology described in 
the HCM Chapter 26, Freeway and Highway Segments: Supplemental, and uses the same basic set of equations. 
The procedure computes LOS, capacity, speed, and density for each segment and for the composite grade as a 
whole. Many of the equations in this section are identical to those presented in Chapter 26, although they have 
different equation numbers. The major difference with composite grades is that the analyst must compute the spot 
travel rates or spot speeds at the start and end of each segment on the composite grade as an input to the analysis 
of the next grade segment. 

Navigation Buttons 
On the Events page and Summary page in a reliability analysis, there are four buttons that can be found at the 
bottom of the table being displayed. These buttons include: << First, < Previous, Next >, and Last >>. When there 
are several scenarios or events in an analysis that are displayed in multiple pages, the user can use the buttons to 
navigate between pages. The ‘<< First’ button will display the first page, the ‘< Previous’ button will display one 
page back, the ‘Next >’ will display one page forward, and the ‘Last >>’ button will display the last page. If all 
scenarios or events can be displayed on one page, then all four buttons will be disabled. 

Number of Lanes on Freeway 
This specifies the number of lanes on the freeway in the analysis direction. If there is a weaving segment, the 
number of auxiliary lanes is also included. When there is a managed lane, the number of lanes is the number of 
general purpose lanes. See also Lane Addition and Lane Drop. 

Number of Lanes on Ramp 
This specifies the number of lanes on the ramp roadway (on- or off-ramp). There can be 1 or 2 lanes. 

Number of Managed Lanes 
This specifies the number of lanes on the freeway that are set aside for specific use in a managed lane. 
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Number of Maneuver Lanes 
Number of lanes from which weaving maneuvers may be made with either one or no lane changes; denoted as 
NWL. 

For one-sided weaving segments, the value of NWL is either 2 or 3. The determination is made by a review of the 
geometric design and the configuration of the segment. 

For two-sided weaving segments, the value of NWL is always 0 by definition. 

Number of Replications 
This number ensures a sufficient sample size for scenario generation in a reliability analysis. 

For a one-year RRP, the methodology is typically applied with four replication for each of five weekdays (Monday 
through Friday) and 12 months in the year, for a total of 240 scenarios. This approach roughly corresponds to 250 
work days in a typical calendar year. A reliability analysis that includes weekend effects would result in an increased 
number of scenarios. 

For RRPs that are significantly shorter than one year, the analyst should increase the number of replications to 
ensure a sufficient sample size for scenario generation. The exhibit below provides guidance on the recommended 
number of replications in such cases. 

 

Oversaturated Flow 
Traffic flow where (a) the arrival flow rate exceeds the capacity of a point or segment, (b) a queue created from a 
prior breakdown of a facility has not yet dissipated, or (c) traffic flow is affected by downstream conditions 

Passenger Car Equivalent (PCE) 
The use of passenger-car-equivalent (PCE) factors is one of two distinct methodologies offered to assess the effect 
of heavy vehicles on capacity and LOS on freeways in the HCM. Traditional PCE factors allow the analyst to convert 
a mixed stream of cars and trucks to a single uniform PCE stream for purpose of analysis. Passenger Cars include 
all sedans, coupes, and station wagons manufactured primarily for the purpose of carrying passengers and 
including those passenger cars pulling recreational or other light trailers. Heavy vehicles include single-unit trucks 
and tractor-trailers. 

For most freeway analyses, PCE tables are sufficient and provide a reasonable approximation of the truck effects. 
However, if truck percentages are high, grades are significant, or both, the mixed-flow model is expected to give a 
more accurate result. If estimates of the actual mixed-flow speeds and densities are desired, the mixed-flow model 
in Volume 4 of the HCM should be employed. If the basic freeway segment is analyzed as part of a freeway facility 
using the methodology in Chapter 10 of the HCM, a PCE approximation is typically appropriate and recommended.
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Peak Hour Factor (PHF) 
The hourly volume during the analysis hour divided by the peak 15-min flow rate within the analysis hour; a measure 
of traffic demand fluctuation within the analysis hour. 

Peak Hour Speed 
The speed expected on the freeway during the peak hour in miles per hour (or kilometers per hour in metric). 

Percent Drop in Capacity 
Percent Drop in Capacity (αwz) refers to the percentage drop in pre-breakdown capacity at the work zone due to 
queuing conditions. Research shows an average queue discharge drop of 7% in non-work zone conditions, and an 
average value of 13.4% in freeway work zones. The underlying research measured pre-breakdown capacities, as 
well as queue discharge rates, to estimate the magnitude of αwz. When there is little local information available on 
αwz, these values can be used as defaults. 

Percent Grade 
The longitudinal slope of a roadway; provided by the user as a percentage 

Percentile Travel Time Index (TTIpp) 
Represents the pp percentile TTI in the travel time distribution. For example, TTI85 means that this observation is 
exceeded only 15% of the time in the travel time distribution. Common TTI percentiles are TTI50 (the median TTI) 
and TTI95 (the 95th percentile TTI). When pp is omitted, the value often represents the mean TTI for the distribution, 
which in HCM chapter 11 is referred to as TTImean. 

Performance Summary 
I In the final step, travel time reliability is described for the entire RRP. The travel time distribution is used to quantify 
a range of variability and reliability metrics. 

Planning Time Index (PTI) 
See 95th Percentile Travel Time Index (TTI95). 

Probability Density Function (PDF) 
The PDF gives the number or percent of all observations within a specified travel time (or TTI) bin. The exhibit found 
below illustrates two types of distributions, with the PDF shown by the solid line and the CDF by the dashed line. 
The facility travel times shown on the x-axis represent the midpoints of the various travel bins. See also Cumulative 
Density Function (CDF). 
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Project Description 
This field is provided for the user to document the analysis with any information for identification purposes. 

Proportion of CAVs 
This is the proportion of CAVs in the traffic stream. CAV is a connected autonomous vehicle, defined here as a 
vehicle with an operating cooperative adaptive cruise control system. The range of proportion of CAVs in the traffic 
stream is from 0 to 100. 

The proportion of CAVs is used in determining a Capacity Adjustment Factor where CAVs are present in the traffic 
stream (CAFCAV). 

Queue Discharge Capacity Drop 
A fraction of capacity drop in queue discharge conditions due to congestion on the facility. If the number of vehicles 
stored on a segment is greater than zero, this indicates that a queue is present on the facility upstream of the node 
in question. The presence of a queue and congestion further indicates that the node capacity is in queue discharge 
mode, which means that the queue discharge capacity is reduced relative to the pre-breakdown capacity by a factor 
α. In order to account for this queue discharge effect, the equation below is applied to any active bottleneck along 
the facility if the number of unserved vehicles stored on the segment is greater than 0.001. 

SC(i,t,p) = (1-α) × SC(i,t,p) 

where 

SC(i,t,p) = segment capacity: maximum number of vehicles that can pass through segment i  in time 
step t  in time interval p  based strictly on traffic and geometric properties 

α = fraction of capacity drop in queue discharge conditions due to congestion on the facility 

Ramp Access Density 
n a network analysis, ramp access density is the total number of ramps 0.5 mi (or 0.8 km in metric) upstream and 
0.5 mi (or 0.8 km in metric) downstream of the segment. 
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Ramp Metering 
Roadway metering is the storing of surges in demand at various points in the transportation network. Freeway on-
ramp metering is an example of roadway metering. A checkbox is provided to indicate whether ramp metering exists 
for a merge or weaving segment when a systems analysis is applied. 

Ramp Metering Rate 
When ramp metering is active, the metering rate, in veh/h, is required and is stored in the existing variable RM(i,t,p), 
as defined in HCM Chapter 25. The maximum output flow rate ONRO(i,t,p) that can enter the merge point takes 
into consideration the ramp metering rate as one of its possible constraints and is properly adjusted if the ramp 
metering becomes the restricting factor to the on-ramp discharge. 

ONRO(i,t,p) is the maximum output flow rate that can enter the merge point from on-ramp i during time step t in 
time interval p; it is constrained by Lane 1 (shoulder lane) flow on segment i and the segment i capacity or by a 
queue spillback filling the mainline segment from a bottleneck further downstream, whichever governs. 

Ramp Overlap Segment 
Whenever a series of ramps on a freeway is analyzed, the 1,500-ft (or 457.2-m for metric) ramp influence areas 
could overlap. In such cases, the operation in the overlapping region is determined by the ramp influence area 
having the highest density. Ramp Overlap Segments are denoted as “R”. 

Random Number Seed 
A random number seed is used with the Monte Carlo methods in the reliability methodology. A seed is used so that 
the sequence of random events can be reproduced. Unique seed numbers are separately established for weather 
events and incidents. For a given set of two seed numbers, a unique combination of demand levels, weather events, 
incidents, and work zones is estimated for each analysis period in the reliability reporting period. 

Reliability Rating 
The percentage of vehicle miles traveled (or vehicle kilometers traveled in metric) on the freeway facility that 
experiences a TTI less than 1.33. This threshold approximates the points beyond which travel times become much 
more variable (unreliable). 

Reliability Reporting Period (RRP) 
The specific set of days over which travel time reliability is computed; for example, all non-holiday weekdays in a 
year. The RRP represents the third dimension that extends the freeway facility core methodology and is illustrated 
in the exhibit found below by the series of rectangles (scenarios). 
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The Start Date indicates the beginning date of the RRP, the End Date indicates the final date of the RRP, and the 
days checked off indicate which days of the week are considered within the timeframe of the RRP.  

The RRP can be as long as one calendar year, although shorter periods are also possible. A one-year RRP is most 
typical, as it encompasses all day-to-day, and month-to-month variability in demand, as well as all weather and 
incident effects. However, shorter RRPs can be used to focus on reliability during specific analysis periods. The 
minimum recommended RRP is one month to capture sufficient variability in demand and other factors. 

Reset to Default Ratios 
The ‘Reset to Default Ratios’ button is provided to undo changes to cells within the Default Freeways Demand 
Ratios table made by the user. If this button is clicked, all cells within the table will revert back to the default values. 

Right Side Clearance 
The right-side clearance is the distance from the rightmost travel lane to fixed obstructions on a freeway; measured 
in feet (or meters in metric). 

Roadway Type 
Roadway types include Multilane Highways or Collector-Distributor (C-D) Roadways and Freeways. For Weavings 
segments, the LOS criteria changes based on the roadway type. For Merge and Diverge segments, the FFS range 
is somewhat lower (45-60 mi/h) and can be estimated by using the methodology in Chapter 12 if no field 
measurements are available. The capacity checks and the maximum desirable flow rates of the ramp influence 
areas also change based on the roadway type. 

Rolling Terrain 
Any combination of grades and horizontal or vertical alignment that causes heavy vehicles to reduce their speed 
substantially below that of passenger cars but that does not cause heavy vehicles to operate at crawl speeds for 
any significant length of time or at frequent intervals. 

Scenario 
A single instance of a study period for the facility, having a unique combination of traffic demands, capacities, 
geometries, and free-flow speeds represented in its analysis periods. Each rectangle in the exhibit found below 
represents a unique scenario, or in other words one day of the year.
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Scenario Generation 
The process of enumerating the various combinations of factors including demand, weather, incidents, and 
scheduled work zones, and calculating their probability of occurrence is termed freeway scenario generation. 

The scenario generator develops a set of scenarios reflecting conditions that the freeway facility may experience 
during the reliability reporting period. Each scenario represents a single study period (typically several hours long) 
that is fully characterized in terms of demand and capacity variations in time and space. The data supplied to the 
scenario generator are expressed as multiplicative factors (CAFs, SAFs, and demand adjustment factors [DAFs]) 
or additive factors (number of lanes) that are applied to the base free-flow speed, demand, capacity, and number 
of lanes. 

The scenario generation process includes the following steps: 

 Adjusting the base demand to reflect day-of-week and month-of-year variation associated with a given 
scenario; 

 Generating inclement weather events on the basis of their local probability of occurrence in a given time of 
year and adjusting capacities and free-flow speeds to reflect the effects of the weather events; 

 Generating various types of incidents on the basis of their probability of occurrence and adjusting capacities 
to reflect their effects; and 

 Incorporating analyst-supplied information about when and where work zones and special events occur, 
along with any corresponding changes to the base demand or geometry. 

The results from these steps are used to develop one scenario for each study period in the reliability reporting 
period. 

The Scenario Generation Settings allow the user to indicate whether or not to include Demand, Weather, Incident, 
and/or Work Zone in scenario generation. 

Scenario ID 
Scenarios generated from the reliability analysis are numbered in a natural order (1, 2, 3, etc.). The scenario IDs 
are numbered starting with the earliest demand combination (i.e., Jan-Mon comes before Jan-Tue). 

Scenario ID for Special Event 
This is provided for the user to enter the appropriate scenario for the special event to be added. 
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Scenario Name 
This is provided for the user to enter a name that describes the corresponding special event. 

Section Length 
Sections are typically divided by ramp gore points and ramp sections can be longer than the 1500 ft (or 457.2 m in 
metric) limited by the operations method. For cases where a ramp section length exceeds 2 mi (or 3.2 km in metric), 
it is recommended to divide the section into multiple sections to avoid having the lower ramp section apply for a 
very long distance. 

Section Name 
This field is provided for each section to identify the section or specify the start point and end point of the section 
under analysis. 

Section Type 
Freeways planning procedure segments the facility into sections. These section can be basic (no ramps), weaving 
(on- and off-ramp with auxiliary lane(s)), or ramp (on, off, or both).  

 

Segment ID 
The segments of a facility are numbered in a natural order (1, 2, 3, etc.). The segment ID number refers to the 
number of the segment found in the Base Dataset Facility graphic in a reliability analysis. 

Segment Length 
Distance in feet (or meters in metric) of each segment. 

Default Segment Lengths 

 Basic: 5280 ft (or 1609.3 m in metric) 

 Merge: 1500 ft (or 457.2 m in metric) 

 Diverge: 1500 ft (or 457.2 m in metric) 

 Weaving: 3000 ft (or 914.4 m in metric) 

 Overlap: 500 ft (or 152.4 m in metric) 

The exhibit below illustrates the influence areas of Merge, Diverge, and Weaving segments without managed lanes. 
A weaving segment is usually defined as the distance between the on-ramp and off-ramp gore points. However, its 
influence area extends 500 ft (or 152.4 m in metric) upstream and downstream of the gore-to-gore length. 



____________________________________________________________________________________________________ 
 Freeways User Guide    Glossary of Terms · 103 

 

Segment LOS 
Segment Level of Service is based on density. See Level of Service (LOS) for Basic Freeway Segment thresholds 
and Freeway Facility thresholds. 

 

Units: USC 

The following table shows the criteria for Freeway Merge and Diverge Segments: 

 

The following table shows the criteria for Weaving Segments: 
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Units: Metric 

The following shows the criteria for Freeway Merge and Diverge Segments: 

LOS Density (pc/km/ln)  Comments 

A ≤6    Unrestricted operations 
B >6-12    Merging and diverging maneuvers noticeable to drivers 
C >12-17    Influence area speeds begin to decline 
D >17-22    Influence area turbulence becomes intrusive 
E >22    Turbulence felt by virtually all drivers 
F Demand exceeds capacity Ramp and freeway queues form 

The following shows the criteria for Weaving Segments: 

     Density (pc/km/ln) 

           Weaving Segments on Multilane 
LOS      Freeway Weaving Segments   Highway or C-D Roads 

A   0-6      0-7 
B   >6-12      >7-15 
C   >12-17      >15-20 
D   >17-22      >20-22 
E   >22      >22 
F     Demand exceeds capacity 

Segment Name 
This field is provided for each segment to identify the segment or specify the start point and end point of the segment 
under analysis 

Segment Type 
There are 5 possible segment types: basic segment, weaving segment, merge segment, diverge segment, and 
overlapping ramp segment. See also Basic Freeway Segment, Weaving Segment, Merge Segment, Diverge 
Segment, and Ramp Overlap Segment. 

Segmentation 
Clicking on the ‘Segmentation’ button will bring up the Segmentation window, where the user can add, insert, and 
delete sections. Clicking OK after finalizing sections will automatically generate the appropriate segments for the 
facility. Clicking Cancel will close the Segmentation window. 

Segmentation usually requires significant analyst time to ensure that the segment types and the computational 
procedures for those segments have been correctly entered. HCM Chapter 10 Section 2 provides guidelines on 
segmenting facilities. 

Segmentation Section Length 
Freeway Section length is measured from gore to gore of the ramps. If there are two freeway sections adjacent to 
each other, then the length is measured to the breakpoint of the two sections. Extremely short sections may cause 
problems with the automatic segmentation. 

Segmentation Section Type 
To complete automatic segmentation, insert a list of each freeway section and each ramp. Ramps need a freeway 
section between them, and multiple freeway sections can be put together. 
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Semi-Standard Deviation 
A one-sided standard deviation, with the reference point being free-flow travel time (or TTI=1) instead of the mean. 
It reflects the mean variability from free-flow conditions. 

Service Volumes 
A checkbox is provided for the user to indicate whether or not to include service volumes tables in the reports. 
Included in the table are Target LOS, Max Service Flow Rate, Service Flow Rate, Service Volume, One Direction 
Daily Service Volume, and Bi-Directional Daily Service Volume. 

Side of Junction 
The location of the ramp(s) relative to the freeway. There are two types: right-sided and left-sided. 

Single-Unit Trucks (SUT) 
Single-Unit Trucks are defined as one of two categories of heavy vehicles. Buses and RVs are treated as SUTs in 
the HCM. SUTs include the following: 

 Other Two-Axle, Four-Tire Single-Unit Vehicles: Two-axle, four-tire vehicles, other than passenger cars. 
Generally pickup trucks, sports utility vehicles, and vans. 

 Buses: All vehicles manufactured as traditional passenger-carrying buses with two axles and six tires or 
three or more axles. Excludes modified buses no longer capable of mass passenger transport. 

 Two-Axle, Six-Tire, Single-Unit Trucks: All vehicles on a single frame with two axles and dual rear wheels. 
Includes some trucks, camping and recreational vehicles, and motor homes. 

 Three-Axle Single-Unit Trucks: All vehicles on a single frame with three axles. Includes some trucks, 
camping and recreational vehicles, and motor homes. 

 Four or More Axle Single-Unit Trucks. All trucks on a single frame with four or more axles. 

Special Event Buttons 
On the Special Event page in a reliability analysis, the user can add and delete special events to be included in the 
reliability analysis. The “Add Special Event” button allows the user to add a special event for the preselected 
scenario. The “Delete Special Event” button allows the user to delete one or multiple special events at a time. The 
user must select the special event(s) to be deleted before clicking the button. 

Special Events 
Special events are short-term events, such as major sporting events, concerts, and festivals that produce intense 
traffic demands on a facility for limited periods. Special traffic control procedures may need to be implemented to 
accommodate the traffic demands. The analyst should identify whether any events that occur in or near the study 
area warrant special treatment. If so, a schedule for the event (dates, starting times, typical duration) should be 
obtained. Some types of events also have varying intensities that will require separate treatment (e.g., a sold-out 
baseball game compared with a lower-attendance midweek game). Recurring events may have developed special 
traffic control procedures; if so, these plans should be consulted to identify any changes required from base 
conditions. Each combination of special event venue and event intensity to be included in the analysis will need to 
be specified. 

Specific Grade 
A single grade of a roadway segment or extended roadway segment expressed as a percentage. 
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Speed 
A rate of motion expressed as distance per unit of time; measured in miles per hour (or kilometers per hour in 
metric) 

Speed Adjustment Factor (SAF) 
Factor used to allow the user to adjust speed based on a combination of different sources, including weather and 
work zone effects. The SAF may also be used to calibrate the estimated FFS for local conditions or other effects 
that contribute to a reduction in FFS. For example, poor pavement conditions or sun glare may result in drivers 
reducing their speeds even under low-volume conditions. 

Spillback Predicted Queue Length 
Queue Length is the distance between the upstream and downstream ends of the queue. The predicted queue 
length is the estimation of the spillback queue length, measured in vehicles. 

Spillback Queue Storage Length 
The maximum storage length for off-ramp queues on segment i is computed as a function of the segment length 
L(i), the deceleration lane length LD(i), and the number of queued lanes NQ(i). 

 

Spillback Shoulder Queue Storage Length 
When a shoulder is present, but its storage length is not sufficient to accommodate the unserved vehicles, this is a 
special case of queue spillback. In the exhibit below, the first case occurs when there is blockage of one mainline 
lane in addition to the shoulder. The second case occurs when there is blockage of two mainline lanes in addition 
to the shoulder.  

 

Study Period 
The time interval within a day for which facility performance is evaluated. It consists of one or more consecutive 
analysis periods, represented by the rows in the rectangles in the exhibit found below. In this example, the study 
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period is 3 h long, running from 4 p.m. to 7 p.m. (i.e., 16:00 to 19:00 hours). The start time is 4 p.m. or 16:00 hours. 
The end time is 7 p.m. or 19:00 hours. 

 

SUT Kinematic End Spot Rate 
Truck spot rates are needed for the mixed-flow model for composite grades. Step 4 of the model computes the SUT 
and TT space-based travel time rates for each of the segments and the spot rates at the end of each segment. The 
first substep involves analyzing the kinematic behavior of the trucks on the grade. The final spot rates are needed, 
as well as a determination of whether the trucks accelerated or decelerated on the grade. 

The graph below can be used for these purposes and are based on kinematic relationships given elsewhere. 
Alternative models of propulsive and resistive forces, such as more complex ones that account for gear shifting, 
can produce longer travel times. Such considerations can be incorporated into the mixed-flow model by adjusting 
the parameter values that affect the tractive effort to account for the additional losses. The travel time rates 
presented here are based on a model that assumes constant peak-engine power. Other models account for the 
power losses that occur for the time intervals prior to an after gear shifting when the engine speed is outside the 
range that produces peak power. 

The graph below shows the trends in SUT spot rates for various grades starting from travel rates of 48 s/mi (75 
mi/h) and 120 s/mi (30 mi/h). Clearly, trucks decelerate as upgrades become steeper. For milder grades, trucks can 
often accelerate. 

SUT Spot Rates versus Distance with Initial Speeds of 75 and 30 mi/h: 

 

For metric units, spot rates are converted from USC units to seconds per kilometer.
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Target LOS 
Target LOS is used in a planning and preliminary engineering analysis. This is the Level of Service (LOS) the 
analyst wishes to achieve based on other parameters, such as Number of Lanes and FFS. 

See also Level of Service (LOS). 

Terrain Type 
An extended length of highway containing a number of upgrades or downgrades where no single grade is long 
enough or steep enough to have a significant impact on the operation of the overall segment. There are three 
types of terrain: Level, Rolling, and Specific Grade. 

See also Level Terrain, Rolling Terrain, and Specific Grade. 

Time Analyzed 
This field is provided to document the time frame of the analysis as morning peak, afternoon peak, existing 
conditions, future projections, etc. 

Total Ramp Density 
The average number of on-ramp, off-ramp, major merge, and major diverge junctions per mile (or kilometer in 
metric). It applies to a 6-mi (or 9.7-km in metric) segment of freeway facility, 3 mi (or 4.8 km in metric) upstream 
and 3 mi (or 4.8 km in metric) downstream of the midpoint of the study segment.  

For segment analyses, ramp density is computed for a 6-mi (or 9.7-km in metric) section centered on the segment’s 
midpoint; however, for facility analyses, ramp density is calculated across the entire facility (i.e., total number of 
ramps divided by total facility length). 

Total Ramp Density Adjustment 
This is an adjustment to Base Free-Flow Speed based on the Total Ramp Density. This adjustment is equal to 
3.22×TRD0.84, where TRD = Total Ramp Density. 

Total Trucks 
The percentage of trucks in the traffic stream. Trucks are heavy vehicles engaged primarily in the transport of goods 
and materials or in the delivery of services other than public transportation. All heavy vehicles are classified as 
single-unit trucks (SUTs) or tractor-trailers (TTs). 

Tractor-Trailers (TT) 
Tractor-Trailers are defined as one of two categories of heavy vehicles. TTs include the following: 

 Four or Fewer Axle Single-Trailer Trucks: All vehicles with four or fewer axles consisting of two units, one 
of which is a tractor or straight truck power unit. 

 Five-Axle Single-Trailer Trucks: All five-axle vehicles consisting of two units, one of which is a tractor or 
straight truck power unit. 

 Six or More Axle Single-Trailer Trucks: All vehicles with six or more axles consisting of two units, one of 
which is a tractor or straight truck power unit. 

 Five or Fewer Axle Multi-Trailer Trucks: All vehicles with five or fewer axles consisting of three or more 
units, one of which is a tractor or straight truck power unit. 

 Six-Axle Multi-Trailer Trucks: All six-axle vehicles consisting of three or more units, one of which is a tractor 
or straight truck power unit.
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 Seven or More Axle Multi-Trailer Trucks: All vehicles with seven or more axles consisting of three or more 
units, one of which is a tractor or straight truck power unit. Includes triple-trailer combinations. 

Traffic Demand 
The methodology accounts for demand variability by adjusting the traffic demands for the analysis periods included 
in the various scenarios. This is done through the use of a demand multiplier, which is the ratio of the daily (weekday-
month combination) facility demand to the average daily traffic (or to any combination of day of week and month of 
year). A second adjustment is needed to factor the demand measured on the specific day-month combination in 
the base scenario to any other day-month combination in the year. Traffic demand variation for different hours of 
the day is already accounted for in the base scenario obtained from the HCM Chapter 10 core facility analysis. 

For example, if the base scenario demand data were gathered on a Monday in January that has a demand multiplier 
of 0.85, and a demand scenario is being tested on a Friday in June that has a demand multiplier of 1.10, then the 
base scenario demands should be factored by a ratio of 1.10/0.85 = 1.29 to create the demand profile for that 
Friday-in-June scenario. When considering all days of the week, there could be up to 84 demand combinations; for 
weekday-only analyses, there could be up to 60 demand combinations. 

Traffic Incidents 
Incidents are generated on the basis of their expected frequency of occurrence per study period (analysis hours in 
a day), in a given month on the facility. The analyst may opt to use default expected incident frequencies, may 
supply a facility-specific incident or crash rate, or may supply a 12-month table of facility specific expected 
frequencies of any incident type. The incident frequency represents the average number of all incidents experienced 
on the facility during the study period, and is allowed to vary in each month. 

The method makes the following assumptions about a given incident: 

 The incident start time is assigned stochastically to any analysis period, which is done automatically by the 
computational engine; 

 The incident duration is assigned stochastically, on the basis of the severity-defined incident duration 
distribution; 

 The incident location is assigned stochastically, weighted by the individual segment vehicle miles traveled 
(VMT) or vehicle kilometers traveled (VkmT); and 

 The incident severity is assigned stochastically, on the basis of the distribution of incident severity. 

Default adjustment factors for incidents are provided in Section 5 of HCM Chapter 11. 

Travel Time 
The time required for a vehicle to travel the full length of the freeway facility from mainline entry point to mainline 
exit point without leaving the facility or stopping for reasons unrelated to traffic conditions 

Travel Time Distribution 
The distribution of average facility travel times by analysis period across the reliability reporting period. Each 15-
min analysis period within each scenario contributes one data point to the travel time distribution. It is not the 
distribution of individual vehicle travel times (or TTIs). 

The travel time distribution and some of its key performance measures are illustrated in the exhibit found below. 
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Travel Time Index (TTI) 
The ratio of the actual travel time to the free-flow travel time. By definition, TTI is always ≥ 1.0. The TTI has an 
identical distribution to travel time, except that its values are indexed to the free-flow travel time. 

TT Kinematic End Spot Rate 
Truck spot rates are needed for the mixed-flow model for composite grades. Step 4 of the model computes the SUT 
and TT space-based travel time rates for each of the segments and the spot rates at the end of each segment. The 
first substep involves analyzing the kinematic behavior of the trucks on the grade. The final spot rates are needed, 
as well as a determination of whether the trucks accelerated or decelerated on the grade. 

The graph below can be used for these purposes and are based on kinematic relationships given elsewhere. 
Alternative models of propulsive and resistive forces, such as more complex ones that account for gear shifting, 
can produce longer travel times. Such considerations can be incorporated into the mixed-flow model by adjusting 
the parameter values that affect the tractive effort to account for the additional losses. The travel time rates 
presented here are based on a model that assumes constant peak-engine power. Other models account for the 
power losses that occur for the time intervals prior to an after gear shifting when the engine speed is outside the 
range that produces peak power. 

The graph below shows the same trends for a TT. Clearly, trucks decelerate as upgrades become steeper. For 
milder grades, trucks can often accelerate. 
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TT Spot Rates versus Distance with Initial Speeds of 75 and 20 mi/h: 

 

For metric units, spot rates are converted from USC units to seconds per kilometer. 

Undersaturated Flow 
Traffic flow where (a) the arrival flow rate is lower than the capacity of a point or segment, (b) no residual queue 
remains from a prior breakdown of the facility, and (c) traffic flow is unaffected by downstream conditions 

Vehicle Hours of Delay (VHD) 
VHD is the vehicle hours of delay during time period t. The facility VHD is the sum of each segment VHD, which is 
calculated using the equation below: 

𝑉𝐻𝐷 = ෍ ൥൭൬𝑉௜ ×
𝐿௜

𝑆௜

൰ − ൬𝑉௜ ×
𝐿௜

𝐹𝐹𝑆
൰൱ × 𝑇൩

௜

 

where 

VHD = Vehicle Hours of Delay (hours/time period) 

Vi = Segment Volume Served (veh/h) 

Li = Segment Length (mi) 

Si = Segment Average Speed (mi/h) 

FFS = Free-Flow Speed (mi/h) 

T = Length of time period (h) 

For metric units, Segment Length is measured in km, while Segment Average Speed and Free-Flow Speed are 
measured in km/h.
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Vehicle Hours of Travel (VHT) 
VHT is the vehicle hours of travel during time period t. The facility VHT is the sum of each segment VHT, which is 
calculated using the equation below: 

𝑉𝐻𝑇 = ෍ ൤൬𝑉௜ ×
𝐿௜

𝑆௜

൰ × 𝑇൨

௜

 

where 

VHT = Vehicle Hours of Travel (hours/time period) 

Vi = Segment Volume Served (veh/h) 

Li = Segment Length (mi) 

Si = Segment Average Speed (mi/h) 

T = Length of Time Period (h) 

For metric units, Segment Length is measured in km, while Segment Average Speed is measured in km/h. 

Vehicle Miles Traveled (VMT) 
VMT is the vehicle miles traveled during time period t. The facility VMT is the sum of each segment VMT, which is 
calculated using the equation below: 

𝑉𝑀𝑇 = ෍[𝑉௜ × 𝐿௜ × 𝑇]

௜

 

where 

VMT = Vehicle Miles Traveled (veh-miles/time period) 

Vi = Segment Volume Served (veh/h) 

Li = Segment Length (mi) 

T = Length of Time Period (h) 

For metric units, Vehicle Miles Traveled (VMT) is converted to vehicle-kilometers per time period and is then 
denoted as VkmT, which stands for Vehicle Kilometers Traveled. 

Volume 
The total number of vehicles or other roadway users that pass over a given point or section of a lane or roadway 
during a given time interval, often 1 hour. 

Volume Ratio (VR) 
The ratio of weaving demand flow rate in the weaving segment to total demand flow rate in the weaving segment. 

Volume-to-Capacity (v/c) Ratio 
The ratio of flow rate to capacity for a system element 

Weather Event Duration 
The duration associated with each weather event is the length of time of the weather event in minutes. The default 
duration for each weather event is the same for each location. If a duration is changed, the weather location 
originally selected will change to ‘Custom’. To revert back to the default values, the user can set the location again.
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Weather Event Probability 
The probability of a weather event happening is displayed for each month based on the location and the study 
period start time and end time. The default probabilities are based on the Metropolitan Weather Database for 
Freeway Reliability Analysis in Volume 4 of the HCM. If any of the probability defaults are changed, the weather 
location originally selected will change to ‘Custom’. To revert back to the default values, the user can set the location 
again. 

Weather Events 
Weather events are generated on the basis of their probability of occurrence during a given month. The scenario 
generation process accounts for ten categories of severe weather events that have been shown to reduce capacity 
by at least 4%, along with a non-severe weather category that encompasses all other weather conditions and that 
generates no capacity, demand, or speed adjustments. Default capacity and speed adjustment factors for weather 
events are provided in Section 5 of HCM Chapter 11. 

To capture the actual occurrences of various weather events, the analyst may use default weather data from any 
of 101 U.S. metropolitan areas, based on 2001-2010 weather records. These values are documented in HCM 
Chapter 25, Freeway Facilities: Supplemental. 

Alternatively, the analyst may supply a 12-month by 11-weather-event matrix (132 total values) of local probabilities 
of each weather event, along with the average duration for each event (10 values). As mentioned earlier, different 
weather events are assigned stochastically to the various scenarios in a manner that will match their monthly 
occurrence based on the site’s meteorological data. 

Weather Type 
There are different types of weather conditions. The HCM categorizes weather into 11 different types. These 
include: Medium rain, Heavy rain, Light snow, Light-medium snow, Medium-heavy snow, Severe cold, Low visibility, 
Very low visibility, Minimal visibility, and Non-severe weather. 

The tables below provide default CAFs and SAFs by weather type and facility free-flow speed. Note that the changes 
in CAFs and SAFs for decreasing visibility shown in the exhibit may be counterintuitive, since they are based on a 
single site. 

The SAF is applied to the base free-flow speed, and CAF is applied to the base capacity, both of which are 
calculated in the respective methodological chapters for the various freeway segment types. Both may also have 
been adjusted in the process of calibrating the core facility in Chapter 10 of the HCM. The adjustment factors below 
should be applied in addition to any prior CAF and SAF calibration. 
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Default CAFs by Weather Type: 

 

Default SAFs by Weather Type: 

 

Weaving Configuration 
Configuration of a weaving segment refers to the way that entry and exit lanes are linked. The configuration 
determines how many lane changes a weaving driver must make to complete the weaving maneuver successfully. 
There are two types of weaving configurations: one-sided and two-sided. 

 A one-sided weaving segment is one in which no weaving maneuvers require more than two lane changes 
to be completed successfully. The following illustrates two examples of one-sided weaving segments: 
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 A two-sided weaving segment is one in which at least one weaving maneuver requires three or more lane 
changes to be completed successfully or in which a single-lane on-ramp is closely followed by a single-lane 
off-ramp on the opposite side of the freeway. The following illustrates two examples of two-sided weaving 
segments: 

 

Weaving Length 
The distance between the merge and diverge that form the weaving segment. There are two measures of weaving 
segment length: short length and base length. 

 LS = short length, the distance in feet (or meters in metric) between the end points of any barrier markings 
(solid white lines) that prohibit or discourage lane changing 

 LB = base length, the distance in feet (or meters in metric) between points in the respective gore areas 
where the left edge of the ramp-traveled way and the right edge of the freeway-traveled way meet 

The following illustrates the two measures of weaving segment: 

 

Weaving Segment 
Freeway segments in which two or more traffic streams traveling in the same general direction cross paths along a 
significant length of freeway without the aid of traffic control devices (except for guide signs). Also freeway weaving 
segment. Weaving Segments are denoted as “W”. 

Weaving Width 
The width of a weaving segment is measured as the number of continuous lanes within the segment, that is, the 
number of continuous lanes between the entry and exit gore areas. Acceleration or deceleration lanes that extend 
partially into the weaving segment are not included in this count. 

Work Zone 
A segment of highway in which maintenance or construction operations reduce the number of lanes available to 
traffic or affect the operational characteristics of traffic flowing through the segment. 

In a Freeways analysis, checking this checkbox indicates there is a work zone present. A set of work zone inputs 
will appear when this box is checked. 

In a Reliability analysis, this portion of the analysis pertains exclusively to scheduled, significant work zone events. 
Minor patching and repair activities are not treated as work zones, but these important activities can be treated as 
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incident events in the procedure and may be added to the incident tally. As such, a work zone constitutes any 
activity that results in scheduled closures of the shoulder or one or more travel lanes. Typically, a work zone lasts 
multiple days or weeks. In some cases, it involves multiple stages, each with different shoulder- and lane-closure 
parameters. 

The details of scheduled work-zone activities must be entered by the analyst and cannot be defaulted. A work-zone 
log should be entered in which the following information is input for each work-zone activity that is planned during 
the RRP: 

 Calendar days of the start and end dates of the work-zone activity; 

 Facility segment(s) and analysis periods impacted by the work-zone activity; 

 Portions of the facility cross-section impacted by closures (i.e., shoulder, one-lane, or multiple-lane 
closures); 

 Type of barrier used to separate traffic from the work activity (i.e., concrete or other hard barrier, or cones, 
drums, or other soft barrier); 

 Regulatory speed limit in effect during the work zone activity; and  

 Lateral separation between traffic and the work zone. 

The methodology can accommodate multiple work-zone activities, each with its own sets of inputs. CAFs and SAFs 
for work zones have been developed by national research and are described in Section 4 of HCM Chapter 10, 
Freeway Facilities Core Methodology. 

Work Zone Buttons 
On the Work Zone page, the user can add, insert, or delete work zone events to be included in the reliability analysis. 
The ‘Work Zone Event +’ button allows the user to add work zone events. An unlimited number of work zone events 
can be added. The ‘Insert Work Zone Event’ button allows the user to insert a work zone event in between existing 
work zone events. The user must select a work zone event to insert a new work zone event before it. The ‘Work 
Zone Event -‘ button allows the user to delete one or multiple work zone events at a time. The user must select the 
work zone event(s) to be deleted before clicking the button. 

Work Zone Duration Analysis Period 
This number specifies how many analysis periods the work zone event lasts. 

Work Zone End Date 
This is the date the work zone event finishes. 

Work Zone Free-Flow Speed 
The work zone free-flow speed is the free-flow speed, in miles per hour (or kilometers per hour in metric), of the 
work zone. When the Work Zone Speed Limit is less than 55 mi/h (or 89 km/h in metric), the input for Work Zone 
FFS will appear and the value entered will be used directly in the computation without checking the speed limit. 

Work Zone Speed Limit 
The work zone speed limit is the speed limit, in miles per hour (or kilometers per hour in metric), of the work zone. 
Higher work zone speed limits and higher speed ratios result in higher work zone FFS. 

Work Zone Start Date 
This is the date the work zone event begins. 
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Work Zone Start Period 
This is the beginning analysis period for the work zone event. 
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